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Safety 

IMPORTANT SAFETY INSTRUCTIONS 

 

   
THE LIGHTNING FLASH WITH ARROWHEAD SYMBOL WITHIN 
AN EQUILATERAL TRIANGLE IS INTENDED TO ALERT THE USER 
TO THE PRESENCE OF UNINSULATED “DANGEROUS VOLTAGE” 
WITHIN THE PRODUCT'S ENCLOSURE THAT MAY BE OF 
SUFFICIENT MAGNITUDE TO CONSTITUTE A RISK OF ELECTRIC 
SHOCK TO PERSONS. 

 

   
THE EXCLAMATION POINT WITHIN AN EQUILATERAL 
TRIANGLE IS INTENDED TO ALERT THE USER TO THE 
PRESENCE OF IMPORTANT OPERATING AND MAINTENANCE 
(SERVICING) INSTRUCTIONS IN THE LITERATURE 
ACCOMPANYING THE PRODUCT. 

 

1. Read these instructions. 

2. Keep these instructions. 

3. Heed all warnings. 

4. Follow all instructions. 

5. Do not use this apparatus near water. 

6. Clean only with a dry cloth. 

7. Do not block any of the ventilation openings.  Install in accordance with 
the manufacturer’s instructions. 

8. Do not install near any heat sources such as radiators, heat registers, 
stoves, or other apparatus (including amplifiers) that produce heat. 

9. Do not defeat the safety purpose of the polarized or grounding-type plug. 
 A polarized plug has two blades with one wider than the other.  A 
grounding type plug has two blades and a third grounding prong.  The 
wide blade or the third prong are provided for your safety.  If the provided 
plug does not fit into your outlet, consult an electrician for replacement of 
the obsolete outlet. 

10. Protect the power cord from being walked on or pinched particularly at 
plugs, convenience receptacles and the point where they exit from the 
apparatus. 

11. Only use attachments/accessories specified by the manufacturer. 

12. Unplug this apparatus during lightning storms or when unused for long 
periods of time. 



13. Refer all servicing to qualified personnel.  Servicing is required when the 
apparatus has been damaged in any way, such as power-supply cord or 
plug is damaged, liquid has been spilled or objects have fallen into the 
apparatus, the apparatus has been exposed to rain or moisture, does not 
operate normally, or has been dropped. 

14. Use the mains plug to disconnect the apparatus from the mains. 

15. Warning: To reduce the risk of fire or electric shock, do not expose this 
apparatus to rain or moisture. 

16. Warning: Do not expose this equipment to dripping or splashing and 
ensure that no objects filled with liquids, such as vases, are placed on the 
equipment. 

17. Warning: The mains plug of the power supply cord shall remain readily 
operable. 

 



End-User License Agreement 

End-User License Agreement for Midas™ and Klark Teknik™ Software. 

IMPORTANT - Please read this document carefully before using this 
Midas™ or Klark Teknik™ product.  This is an agreement governing your 
use of software or other machine instructions already installed on the 
Midas™ or Klark Teknik™ product, as well as other software that we 
provide for installation on the product.  The Midas™ or Klark Teknik™ 
product will not operate in accordance with its documentation without this 
software. 

THIS AGREEMENT ("AGREEMENT" OR "LICENSE") STATES THE TERMS AND 
CONDITIONS UPON WHICH TELEX COMMUNICATIONS (UK) LTD. ("COMPANY") 
OFFERS TO LICENSE THE INSTALLED FIRMWARE, SOFTWARE, AND/OR PROGRAM 
("the SOFTWARE") WITH THE MIDAS™ OR KLARK TEKNIK™  CONSOLE  OR 
SIGNAL PROCESSING PRODUCT ("PRODUCT") IN WHICH IT WAS INSTALLED BY, 
OR PROVIDED FOR BY, THE COMPANY. YOU ARE AGREEING TO BECOME BOUND 
BY THE TERMS OF THIS LICENSE. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS LICENSE, DO NOT USE THIS PRODUCT. PROMPTLY RETURN THE PRODUCT 
TO THE PLACE WHERE YOU OBTAINED IT FOR A FULL REFUND.  You agree to 
notify any persons who you permit to operate this Product of the terms of this 
License, and to expressly obligate them in writing to comply with these terms. 

The installed software as supplied by the Company is licensed, not sold, to you 
for use only under the terms of this License, and the Company reserves all rights 
not expressly granted to you. You own the Product on or in which the Software 
has been installed by the Company, but the Company retains ownership of all 
copies of the Software itself, including those stored on or in the Product. 

1. License:  This limited License allows you, and other persons you permit to 
operate the Product, to use the Software only on the single Product unit in 
which it was installed. 

2. Restrictions:  (a) The Software and the accompanying written materials 
are copyrighted, and contain trade secrets and other proprietary matter, 
including confidential information relating to the specifications and 
performance characteristics of Company's products.  The Software is 
protected by state trade secret laws as well as U.S. and international 
copyright and intellectual property laws and treaties.  All rights to 
copyrights, trademarks and trade secrets in the Software or any 
modifications to it are owned by Company.  Unauthorized copying of the 
Software or any portion thereof, or copying of the written materials, is 
prohibited.  (b) You may not create, market, distribute, or transfer copies 
of the Software to others or electronically transfer or duplicate the 
Software, or rent, lease, or loan the Software, except in conjunction with 
the sale, transfer, loan, rent, or lease of the Product on which it is 
installed, and subject at all times to this License. YOU MAY NOT REVERSE 
ENGINEER, DECOMPILE, DISASSEMBLE, MODIFY, ADAPT, PORT, OR 
TRANSLATE THE SOFTWARE OR CREATE DERIVATIVE WORKS BASED ON 
THE SOFTWARE OR ANY ACCOMPANYING WRITTEN MATERIALS. (c) In the 
event you violate any term of this Agreement, all licenses granted herein 
automatically terminate and you must stop using the Software and destroy 
any copies of the Software or remove them from the Product. 



3. Limited Warranty:  Subject to your installation of any Software updates 
issued by the Company as described herein, the Company warrants that 
the Software shall cause the Product to operate in compliance with the 
Product's material specifications and documentation for a period of 90 
days from your purchase of the Product.  The Company does not warrant 
that the operation of the Software will meet your requirements or operate 
free from error. The Company DISCLAIMS ALL WARRANTIES AND 
CONDITIONS EITHER EXPRESS OR IMPLIED, INCLUDING THE 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NON-INFRINGEMENT OF THIRD PARTY RIGHTS.  You 
understand that the Company may update or revise the Software and in 
so doing incurs no obligation to furnish such updates to you.  However, 
the Company may in its discretion make updates available from time to 
time upon such terms and conditions as it shall determine.  It is a 
condition of any warranty granted pertaining to either the Software or the 
Product, that you install any such Software updates, as may be issued 
from time to time by the Company for the Product or the Software, in 
accordance with Company's instructions.  You may view current Software 
updates at http://www.klarkteknik.com and 
http://www.midasconsoles.com. 

4. Limited Liability: THE LIABILITY OF THE COMPANY FOR ANY CLAIMS 
ARISING OUT OF THIS LICENSE AND/OR BASED UPON THE SOFTWARE, 
REGARDLESS OF THE FORM OF ACTION, SHALL NOT EXCEED THE 
GREATER OF THE LICENSE FEE FOR THE SOFTWARE OR THE COST OF THE 
PRODUCT.  IN NO EVENT SHALL TELEX BE LIABLE FOR ANY LOSS OF 
DATA, LOST OPPORTUNITY OR PROFITS, COST OF COVER, OR SPECIAL, 
INCIDENTAL, CONSEQUENTIAL, OR INDIRECT DAMAGES, EVEN IF YOU 
ADVISE COMPANY OF THE POSSIBILITY OF SUCH DAMAGES.  THIS IS AN 
ESSENTIAL TERM OF THIS AGREEMENT AND YOU ACKNOWLEDGE THAT 
THE AMOUNT YOU PAID FOR THE PRODUCT AND SOFTWARE REFLECTS 
THIS ALLOCATION OF RISK. 

5. Other Third-Party Computer Programs:  As referred to herein, the 
term "Software" refers only to proprietary Midas™ or Klark Teknik™ 
Software, developed by Company, that has been provided to you for 
installation on, or already installed in, your Midas™ or Klark Teknik™ 
Product.  In addition to this Software, you may have also been provided, 
at no additional charge, a version of the widely-available Linux software, 
which is a modular operating system made up of hundreds of individual 
software components, each of which were written and copyrighted 
individually by various parties (collectively, the "Linux Programs").  Each 
component has its own applicable end user license agreement.   Many of 
the Linux Programs are licensed pursuant to a Linux End User License 
Agreement ("Linux EULA") that permits you to copy, modify, and 
redistribute the Software.  However, you must review the on-line 
documentation that shares a directory or otherwise accompanies each of 
the Linux Programs included in this Product, for the applicable Linux EULA. 
 Nothing in this license agreement limits your rights under, or grants you 
rights that supersede, the terms of any applicable Linux EULA.  If you wish 
to receive a computer-readable copy of the source code for the Linux 
programs that have been provided with your Midas™ or Klark Teknik™ 
product, send a check or money order (no cash accepted), your address, 
and $10.00 to cover the cost of optical media, postage and handling, to: 
 
     Telex Communications (UK) Ltd. 
     ATTN:  Linux Programs CD for Midas™/Klark Teknik™ 



     Walter Nash Road, 
     Kidderminster. 
     Worcestershire. 
     DY11 7HJ. 
     England. 
 
In your request, indicate your Product's name and model number, serial 
number, and version/release information.  This offer made pursuant to the 
Linux EULA may expire according to the terms of the Linux EULA, in which 
case your check will be returned to you or destroyed at our option. 
 Please note that the Linux distribution that may be available to you 
under this offer consists of the Linux kernel only and does not contain 
any application software not covered by the Linux EULA.  Other 
updated Linux distributions containing application software are widely 
available from a variety of Internet sources, and are often available at 
minimal or no cost. 

6. Termination:  This License will terminate immediately if you violate any 
of the License terms.  Upon termination you must discontinue use of the 
Software, and either destroy, erase, or return to Company all copies of the 
Software in your possession, custody or control, including those in or on 
the Product. 

7. General:  This License constitutes the entire agreement between you and 
Company with respect to this Software and supersedes any other 
communication (including advertising).  If any provision of this License is 
held unenforceable, that provision shall be enforced to the maximum 
extent permissible so as to give effect the intent of this License, and the 
remainder of this License shall continue in full force and effect.  This 
License shall be governed by the laws of the State of Minnesota, and the 
federal laws of the United States, without reference to conflict of laws 
principles.  You agree that the United Nations Convention on Contracts for 
the International Sale of Goods is inapplicable to both this License and to 
the sale of the Product. 



Introduction 

Introduction 

The Klark Teknik DN9696 Recorder is a hard disk recording and playback system, 
which is able to record 96 tracks of high resolution, 96kHz, 24-bit digital audio 
material. 

It can be integrated with a Midas digital console, such as an XL8 or PRO6, to 
provide the simplest of solutions for making a multi-track recording of a 
performance, and also includes virtual soundcheck features to assist the live 
engineer during sound check. 

The system is housed in a 5U rack mount unit with the most important controls 
and level metering for all 96 tracks on the front panel, so that they can always be 
accessed and monitored.  A computer monitor, keyboard and mouse can be 
connected to the DN9696 to form a graphical user interface (GUI) that provides 
visual representations of the audio while recording, and give you control over the 
advanced features and file management. 

Do not use external USB, FireWire or eSATA devices unless they are 
known to be free of viruses or other malware.  There is no virus 
protection software installed on the DN9696, as this would greatly impair 
performance.  Do not install any third party software.  Do not connect to 
a non-AES50 Ethernet network.  Failure to adhere to the above may 
result in voiding the warranty. 

Quick Start 

The Front Panel 

The Software 

 

Contact Details 

IMPORTANT SAFETY INSTRUCTIONS 

EULA 

 



Quick Start Recording 

Quick Start 

This section aims to get you to the most important function of all - recording a 
concert or soundcheck - as quickly as possible.  The DN9696 has been designed 
to make this fundamental task simple and quick, and you will be using the front 
panel controls to start the recording.  Once you have mastered that, we will 
investigate the wealth of other features available within the system. 

Connections 

Hard Disk Drives 

Starting Up The Software 

Recording 



Connections 

Audio Connections 

Four pairs of AES50 connectors on the rear panel of the DN9696 are connected to 
the Midas digital console. 

The printed Quick Start Guide (part number DOC04-DN9696QSG), which is 
supplied with the system, has full connection details, particularly on how to 
connect the DN9696 to Midas digital consoles and also what you can connect to 
the front of the unit itself. 

This manual describes the operation of the DN9696 with a Midas digital system. 
 However, connection to other AES50-equipped digital audio systems is also 
possible. 

Each AES50 connection provides 24 channels of 96kHz input and output.  The 
AES50 cables are duplicated for dual redundancy where applicable. 

Computer Connections 

You will need to connect an XGA screen plus a mouse and keyboard to the 
DN9696 via the connections on the rear panel.  Ideally, you will be connected to 
the digital console's KVM (keyboard, video, mouse) switch, so that you can use 
the mouse, keyboard and screen from the console.  The mouse and keyboard 
may be connected via USB, while PS2 connections are also available. 

LTC 

The DN9696 has a connection for an LTC input on a balanced female XLR 
connector if timecode synchronisation is required. 

Power 

Mains power is provided via a standard 3-pin IEC power connection on the rear 
panel.  Next to this is a mains on/off switch. 

 



 
Hard Disk Drives 

The DN9696 is supplied with enough internal storage to record 96 tracks of 
96kHz/24-bit audio for a minimum of nine hours. 

Additionally, it is possible to record a duplicate set of recordings to external 
mirror drives, which the user will need to provide.  The mirror drives provide a 
backup, as well as a quick method of taking the recordings away after the concert 
— perhaps to pass the material on for mixing or post-production.  FireWire 800 
and eSATA interfaces are provided to connect the mirror drives.  If more than 48 
tracks are being recorded, two mirror drives must be attached.  Ideally, you will 
provide two mirror drives that are at least as large as the internal drives, that is, 
500GB or greater. 

We recommend that the external drives are connected before the DN9696 has 
started up, so that they will be offered as mirror disks when you first create the 
project. 

IMPORTANT: 
You must not physically remove drives before safely removing them in 
the software. 

There is a third drive inside the DN9696 unit, but this is the operating system 
drive and cannot be used for audio recording.  USB 2.0 interfaces are available 
for attaching other devices, but it is not recommended to use these for either the 
primary or mirror audio recordings. 

IMPORTANT: 
The audio drives MUST be formatted correctly to ensure optimal system 
performance (see "Formatting the audio drives" below). 

IMPORTANT: 
NEVER use the USB external HDDs for mirror recording, as there is 
insufficient bandwidth. 

Note: The WAV format has a file size limit of 4GB, which gives you 
approximately four hours of recording time with the DN9696, irrespective of the 
number of tracks in 'record'.  Therefore, you should ensure individual takes or 
sessions last no longer than approximately four hours. 

Formatting the audio drives 

The audio drives are formatted in Windows Disk Management. 

 To format the audio drives 

1. Open Disk Management by choosing Start > Control Panel > 
Administrative Tools > Computer Management > Storage > Disk 
Management. 

2. In the Volume column, right-click the Audio 1 drive and choose Format. 

3. In the Format window, choose 64K from the Allocation unit size drop-
down list (shown below). 



 

 

4. Click OK. 

5. Repeat steps 2 to 4 for the Audio 2 drive. 

 



 
Starting Up The Software 

Double-click the DN9696 icon to start the application. 

After the DN9696 has started up, the Project Startup window will open.  This 
has three project options from which to choose: you can open the most recent 
project; you can open an existing project; or you can create a new project from 
scratch. 

Details of how to power up the DN9696 and start up the DN9696 software can be 
found in the DN9696 Quick Start Guide. 

 

To create a new project, click Create a new Project in the Project Startup 
window. 

 

In the New Project window, choose the parameters you want for your new 
project as follows: 

 In the Project Name field, use the keyboard to type in a name for your 
new project. 



 In the Frame Rate field, select the frame rate from the drop-down list; 
this is only necessary if the DN9696 has timecode connected.  (To open 
the drop-down list, click the down arrow at the right of the field.  Then, 
click the list option you want.) 

 Track count: Choose the number of tracks you expect to be recording 
from the AES50 1 & 2 and AES50 3 & 4 fields.  Internally, the DN9696 is 
separated into two units, each being capable of a maximum of 48 tracks. 
 If you are recording more than 48 tracks, it is advantageous to split the 
tracks equally across both units.  This is because each unit records to a 
different disk drive and thus ensures that the hard drives fill up evenly, 
which could make management of the drives a little simpler and give you 
a longer recording time. 

 Primary/mirror record disks: You will not be expected to change the 
primary disks, as the two internal drives are pre-selected.  However, if 
there is a choice of external disk drives, select the pair you want from the 
drop down list in the Mirror (External) Record Disks: field. 

The Sample Rate is fixed at 96kHz. 

When you have selected the parameters you want for your new project, click 
Create.  The main DN9696 screen will open (see DN9696 Display), which displays 
up to 96 empty tracks that are waiting to be recorded to. 

 



Recording 

To make a recording, use the transport controls on the front panel of the 
DN9696. 

 

To record arm all audio tracks in your project, press RECORD 
and hold it down for least one second.  The ARM/REC LEDs 
should flash.  If an audio source is selected, you should see the 
meters moving, both on the panel and in the software, to 
indicate the presence of audio. 

 

To start the recording, press PLAY and RECORD simultaneously. 
 While the DN9696 is recording, all controls are locked out as a 
default (see"Record lock" in Transport Controls). 

 

To finish the recording, press STOP and hold for at least two 
seconds. 

 

To disarm all of the audio tracks, press STOP and RECORD 
simultaneously and hold down for at least three seconds. 

 



Front Panel 

Front Panel 

The front panel of the DN9696 is divided into two main sections.  The right side 
houses the main controls, while the channel meters are on the left. 

 

The all important transport controls (PLAY, STOP and RECORD buttons) and the 
time display are towards the upper-right corner of the front panel, and to the 
right of these is the power button.  Below these are sections for two other sets of 
functions that you may want to use while the recording is in progress, 'solo' and 
'marker'.  In between these sections is the hard disk section, which has two USB 
connectors for attaching other devices, and status LEDs for each of the primary 
and mirror record drives. 



 

Note: It is not advisable to use USB ports for mirror recording drives as 
the performance of USB may not be suitable. 

The channel meters section has meter and status LEDs for each of the 96 
channels.  To the left of these are the AES50 status LEDs and navigation buttons. 

 

 



 
Time Display 

 

Press the TIME button (right of time display) to cycle through the following three 
time display modes. 

 ELAPSED — the display shows the project's current timeline. 

 REMAINING — the display shows how much disk space is remaining on 
the disk drive with the least available space.  This is expressed as the 
length of time you can record for, based on the number of tracks that are 
currently record armed, or the maximum number of tracks in the current 
project if nothing is armed. 

 LTC — the display shows the time of any external LTC source.  If the 
DN9696 is online and following the timecode.  However, it is possible to 
set a timecode offset, in which case they would be different.  For more 
information, see LTC Sync. 

Times for ELAPSED and REMAINING are displayed in hours : minutes : seconds 
: hundredths of a second.  If the display is set to LTC, it displays frames instead 
of hundredths of a second. 



Play, Stop And Record 

 

Playback 

To start playback from the current time, press PLAY. 

Note: Playback cannot be started if there are any tracks record armed. 
 The DN9696 is optimised to record a large number of high quality audio 
tracks and does not allow 'overdub' or 'punch-in' recording.  As the most 
fundamental task of the DN9696 is recording, when tracks are record 
armed it is expected that the user will want to start a recording as quickly 
as possible. 

Stopping 

To stop playback, press STOP. 

To stop recording, press and hold down STOP for at least two seconds.  This is so 
that a momentary accidental press of the button does not spoil a recording. 

Recording 

To start the recording, press PLAY and RECORD simultaneously. 

Record arming/disarming 

To record arm all tracks in the project, press and hold down RECORD for at least 
one second. 

To disarm all tracks, press and hold down STOP and RECORD for at least three 
seconds. 

 



Solos 

 

You can monitor a mix or an individual channel of the recording by connecting a 
set of headphones to the PHONES socket (1/4" stereo jack) in the SOLO BUS 
section of the front panel. 

Adjust the level of the headphone output using the LEVEL control knob. 

To solo a single track, press the yellow SOLO button.  Select the track you want 
to solo using the solo selector control knob .  As you adjust the control knob, 
a yellow LED underneath the track number (left side of front panel) will illuminate 
to show which track is being soloed. 

To disable solo mode, press SOLO again.  The yellow LED under the last track 
soloed will flash to show that this track will be soloed if you enable solo again. 

The software interface has individual solo buttons (S) that allow you to solo 
multiple tracks, as well as a separate mute button (M) for each track. 

When the SOLO button is off and solo mode is disabled, the headphone jack will 
output a unity level mixdown of all 96 tracks. 

When a SELECT button on one of the banks is being used to restrict the software 
screen's view to 24 tracks, this will also restrict the solo selector control knob 

  to the same 24 tracks.  For a description of the bank selectors, see "Bank 
Select". 

Monitoring 

The headphone jack will only monitor the inputs to the DN9696 on tracks that are 
record armed.  When no tracks are record armed, the headphones monitor 
playback. 

 



Markers 

 

You can set any number of markers — also known as "locators" — at positions in 
the timeline, so that you can easily return to those positions.  This is done via the 
MARKER section of the front panel. 

To set a marker, press SET.  Markers are numbered in the order they are set, 
and therefore not necessarily in sequential order down the timeline. 

The FORWARD and BACK buttons move the timeline to the next or previous 
marker, respectively (when the unit is in 'stop' mode).  This cannot interrupt a 
recording. 

You can set markers using a standard foot switch instead of using the SET 
button.  Connect the foot switch to the FOOT SWITCH jack socket (front panel). 
 When you operate the foot switch a marker is set. 

There are a number of other facilities that use markers within the software, 
including the ability to quickly set playback loops between consecutive markers in 
order to assist with a virtual soundcheck.  For details, see "Markers and Locators"' 
in the "Playing and Locating" chapter. 

 



Power Button 

Pressing the DN9696's recessed POWER button  (upper-right corner of the 
front panel), switches the unit on. 

Power down the DN9696 

As the DN9696 is essentially a computer, you should turn it off by shutting down 
its software properly, just as you would on any normal PC.  This allows the 
software to close its files, exit programs etc., and shut down 'cleanly'.  To prevent 
the inadvertent shutdown of the DN9696, the shutdown sequence cannot be 
initiated by a normal press of the POWER button.  To turn off the DN9696: 

1. Close the DN9696 software either by clicking the X button (upper-right 
corner of window) or by choosing File > Exit. 

2. Shut down the Windows® XP operating system by clicking start and then 
choosing Shut Down. 

The unit will take a short while to shut down, and will turn the power off 
automatically.  Do not remove the power cable until the DN9696 has finished 
shutting down. 

In extreme circumstances you can use the POWER button to shut down the 
system.  To do this, press the POWER button and hold it down for a minimum of 
four seconds.  However, do not do this in normal circumstances, as recordings 
may be lost. 



96 Channel Meters 

The left side of the front panel of the DN9696 houses the LEDs for the 96 
channels.  To the left of these are the AES50 status LEDs and navigation buttons. 
 This section is arranged in four banks, each one containing 24 channels, an 
AES50 section and a SELECT button. 

 

Channels 

Each of the 96 channels has a set of the following LEDs: 

 
Level — four LEDs indicate the following: red = level clipping; yellow = 
peaks over -6db; upper green = peaks over -18db; and lower green = a 
signal is present. 

 SOLO — a yellow LED that indicates when its track is being soloed.  The LED 
is continually illuminated when its track is being soloed, and flashes when 
solo is disabled to show that its track will be soloed if the main SOLO button 
is pressed again. 

 ARM/REC — a red LED that illuminates when its track is record armed.  An 
ARM/REC LED will flash when its track is armed, but not recording; it is 
continually illuminated when the recording is in progress. 

AES50 input status 



To the left of each bank of 24 channels are the AES50 status LEDs, which show 
the condition of each of the four pairs of AES50 inputs, for both the X and Y 
networks of the digital audio system. 

The green OK LED pulsates when the AES50 input is present and locked.  While a 
constantly illuminated red ERROR LED shows that there is an error condition on 
that connection. 

The AES50 connections of the DN9696 are dual redundant.  If both the X and Y 
networks are connected, the OK LEDs of the active network will pulsate, while the 
ERROR LEDs of the inactive network will remain on. 

Bank select 

There are four SELECT buttons, one to the lower-left of each channel bank. 
 Pressing a SELECT button changes the view on the software interface so that it 
focuses on the bank (set of 24 channels) associated with that button.  The button 
is illuminated with a blue backlight when its bank is focused. 

Pressing an illuminated SELECT button returns the vertical zoom, so that all of 
the tracks in the project are in view. 

When a bank of 24 tracks is focused by this method, the solo selector control 
knob  is restricted to that particular range of tracks. 

 



Software Display 

DN9696 Display 

After the DN9696 has started up and a project has been loaded, the screen will 
look typically like the one in the following diagram. 

 

1. Edit toolbar 
2. Playlist tools 
3. Current timeline 
4. Online button, enables 
LTC 
5. Transport controls 
6. Source files folder 
7. Time display 
8. Track name buttons 
9. Solo (S), mute (M) and 
record (R) buttons 

10. Meters 
11. Status bar - tips and info area 
12. Clips 
13. Status bar - clock source/frame rate 
14. Horizontal/vertical zoom buttons 
15. Primary record disks information 
16. Mirror record disks information 
17. File naming and metadata 
 

 



Playlist 

After start-up, the display of the DN9696 comprises a main screen.  The main 
feature of this screen is the centre section — called the "playlist" — which 
displays up to 96 separate, vertically-stacked audio tracks.  Each of these tracks, 
known as "clips" or "playlist entries", has a timeline that runs from left (earliest) 
to right (latest).  During playback and recording, a dotted vertical current timeline 
remains stationary, while the graphical representations of the audio waveforms 
move from right to left, passing through this point as they play. 

Note: The playlist section is sometimes referred to as an "EDL".  When 
you save your work it is saved to an .edl file. 

Initially, so that all of the 96 tracks fit on the screen simultaneously, each one is 
quite thin.  However, you can enlarge them to see the audio waveforms in more 
detail.  This can be done either by using the zoom buttons (lower-right corner of 
main screen) or the SELECT buttons to the left of the DN9696 unit's front panel. 

The audio waveforms are created as the DN9696 records.  These are displayed in 
different colours, which have some significance, although this is mainly when 
editing.  These are explained later in this chapter. 

 



Saving Your Project 

To save any changes to your project, choose File > Save.  You can do this during 
editing or when you have finished editing.  However, we recommend that you 
save your work regularly.  You will be prompted to save when you exit the 
DN9696. 

When you save your project, playlist information such as the layout and the order 
in which the recordings are played back, are stored. 

Note: Saving your project has no effect on the recorded audio files.  This 
is because they are saved as they are recorded, and are never 
subsequently modified.  Therefore, they never need to be saved again.  All 
audio editing on the DN9696 is non-destructive. 

 



Buttons And Menus 

In common with most Windows® applications, the main DN9696 window has a 
title bar at the top and a menu bar underneath.  The title bar shows the name of 
the document or program, while the menu bar contains a number of commands. 
 Click a command to open its menu, for example, click File. 

 

 

For most common tasks the system has been designed for operation by 
clicking on-screen buttons or by using the hardware controls on the front 
panel of the DN9696 unit.  The on-screen buttons have a 3-D appearance 
and should look 'depressed' in their on position. 

At the lower-left of the screen, the tips and information area (left of status bar) 
shows you what the on-screen buttons are when you point at them. 

The majority of DN9696 functions can be assigned to keyboard shortcuts, or 
"hotkeys".  The method for assigning hotkeys is discussed in the "Setup" chapter, 
and hotkey alternatives for functions are mentioned throughout this manual.  The 
DN9696 software is supplied with a default set of pre-assigned hotkeys already 
loaded. 

If you rest the pointer over a button for a few seconds, a yellow box will appear 
(shown below) that contains information on the button's function, followed by its 
hotkey assignment (in brackets).  Also, the status bar (lower-left corner of 
screen) describes its action. 

 

Right-click certain areas to open their context-sensitive menus. 

 



 
Time Display Window 

The current time is displayed both on the hardware front panel of the DN9696 
unit and also in the upper-right corner of the screen.  Additionally, there is a re-
sizeable floating window that you can, for example, enlarge so that you can see it 
from a distance. 

To open the Time Display window, choose View > Time Display Window. 

 

Similarly to any window in a Windows®-based application, you can resize it and 
move it where you want. 

 To resize a window, use drag.  Move the pointer over a corner or edge of 
the window and then, when the line with the double-arrows  appears, 
drag the corner of the window to resize it. 

 To move a window, use drag.  Move the pointer over the title bar of the 
window and then, drag the window wherever you want. 

There are two buttons along the top of the Time Display window — Current and 
Auto — that allow you to change what time is displayed and in which format. 

Time display mode 

By clicking Current (default text of button), a menu opens from which you can 
choose the reference point for the time display. 

 

Current Displays the current time in the playlist. 

Countdown Counts down to the end of the final clip in the 



playlist. 

Play Counts up from where playback started. 

Start Counts up from the start of the first clip in the 
playlist. 

Start of clip Counts up from the start of the first clip that is 
selected in red.  If no clips are selected, "--:--:--" 
will be displayed.  The Time Display window will 
show a negative time if playback is started before 
the start of the first  
red-selected clip. 

End of clip Similar to Start of clip, except that it counts 
down to the end of the final red-selected clip. 

PQ Track N/A. 

Time format 

Clicking the Auto button opens a menu from which you can change the format of 
the displayed time. 

 

Auto Time Display follows the global setting, and thus 
is the same as the main time display at the top 
right of the screen. 

Timecode Displays the time as timecode.  Frames/second 
are displayed as per the frame rate setting, and 
there are 80 bits per frame. 

Display format = hours : minutes : seconds : 
frames . bits. 

Milliseconds Displays the last digit as milliseconds (default). 

Display format = hours : minutes : seconds . 
milliseconds. 

Samples Displays the last digit as samples (96000 per 
second). 

Display format = hours : minutes : seconds . 
samples. 



CD Displays the last digit as CD frames (75 per 
second). 

Display format = hours : minutes : seconds . CD 
frames. 

Bars and 
beats 

Displays the time as bars and beats as per the 
general setting for bars and beats. 

Display format = bar : beats : parts per quarter 
note. 

Customising the time display 

You can open a menu by right-clicking within the Time Display window.  This 
menu contains commands that allow you to access the display mode and display 
format selectors, show/hide the title bar and tool bar, and close the Time 
Display window. 

 

Show title bar Tick this command to show the title bar of the 
Time Display window and untick it to hide the 
title bar. 

Note: Once you have hidden the title bar, you 
will not be able to reposition the Time Display 
window other than by resizing. 

Show toolbar Tick this command to show the toolbar and untick 
it to hide the toolbar. 

Time display 
mode 

Select the time display mode from a submenu 
using this command. 

Time display 
format 

Select the time display format from a submenu 
using this command. 

Close window Closes the Time Display window. 

 



 
Playlist Controls 

 

 

The left of the playlist contains some important buttons that provide individual 
control for every audio track: 

 At the far left of the playlist are the track name buttons, which are 
used for track identification.  At the start of a project they are 
numbered from 1 to 96 by default.  However, you can rename them 
to make it easier to identify where each is receiving its audio input 
from, such as an instrument or microphone.  For example, you use 
the name "kick" for a kick drum. 

To rename a track, right-click on its name button and choose 
Rename.  Then,type in the name of the track followed by ENTER. 
 (Pressing ESC exits the track name button field without saving any 
editing.) 

Note: You can also rename a track name button by right-
clicking on the adjacent S, M or R buttons and choosing 
Rename Stream. 

Having named every track in the playlist you can save this list in a 
template.  This is useful if you plan to use the same naming scheme 
again.  For example, for a concert the following day.  To save the 
track name list, choose Playlist > Save Stream Name Template. 
 To load an existing track name list into the current playlist, choose 
Playlist > Load Stream Name Template. 

 

 

By default the keyboard has several hotkeys to help you 
name tracks: 

 TAB: 'Focuses next track' by moving the red border 
from one track button to the next.  The red border 
shows which track is focussed. 

 SHIFT+TAB: 'Focuses previous track'. 

 Q: Opens the track name button so that you can edit 
its name.  You must finish editing by pressing ENTER, 
otherwise the interface will appear to be locked out. 
 (It is always possible to start a recording, even when 



in this editing mode.) 

These hotkeys can be set in the Playlist - Stream Focus 
category of Hotkey Setup. 

You can change the Colour of a track from the menu that 
opens when you right-click on its track name button.  The 
clip's waveform stays the usual colour, but a colour wash is 
applied to the background. 

 The yellow Solo button (adjacent to each track name button) 
provides an alternative method of soloing, instead of using the SOLO 
BUS controls of the front panel.  As the logic of the software buttons 
is additive, you can use the mouse to solo multiple tracks to the 
headphone output. 

The solo hotkey (default S) solos a single 'focussed' track. 
 TAB/SHIFT+TAB focus the next/previous track. 

  The Unsolo All/Restore last solos button (above top track of 
playlist) clears all solos.  If you click this button again when no solos 
are applied, it will restore the previous solo state, allowing you to 
switch between solo and the full mix. 

 The orange Mute button mutes individual tracks. 

The mute hotkey (default M) mutes a single track that has been 
'focussed' by pressing TAB/SHIFT+TAB. 

 The red Rec enable button record enables individual tracks.  You will 
usually be using the RECORD button on the front panel to record all 
tracks.  Record all is also available by choosing Playlist > Record 
enable selected streams; the Playlist menu also contains the 
Disarm all record enabled streams command. 

This button flashes when its track is record enabled and changes to 
constantly illuminated during recording. 

The record hotkey (default R) switches the record enable on/off 
for a single track that has been 'focussed' by pressing 
TAB/SHIFT+TAB. 

 

 

 

When the input is record enabled or when the DN9696 is 
in playback, there is an LED metering display (Peak to 
Peak Meter) for level, and a digital Peak / Fader level 
display (in dBFS). 

 

The two buttons above the top track of the playlist (far right) change 
the behaviour of the meters.  The Peak hold mode button (left) 
changes the peak hold mode — whether the peak segment remains 
lit (button in) or whether it clears every few seconds.  The Clear 
peaks button manually clears the numeric peak hold displays. 



 
The Show all as profiles button switches the clip display between 
waveforms (also known as 'Profiles' - button down) or blocks, which 
may sometimes make it easier to see the breaks between clips. 

 

The Show/hide text pane button shows/hides the Text Edl and 
Locators tabs, which appear in a panel towards the bottom of the 
screen.  Both of these tabs display playlist details in a 'spreadsheet' 
style format. 

 
The Show/hide stream and groups list button shows/hides the 
GROUPS sidebar (far left), which allows you to group tracks together 
so as to operate on them simultaneously.  For example, you may 
choose to group all the percussion tracks so as to mute or solo them 
as one. 

 
The Show/hide source tracks pane button shows/hides an area on 
the right of the screen, which has three main regions: 

 Source Tracks Folder — shows an entry for every recording 
made. 

 File naming and Metadata section. 

 Primary and mirror record disks information section, where 
you can change the drives being recorded to, and which shows 
more information about those disk drives. 

 
The Show/hide inputs button shows/hides a button on every track 
to allow you to reassign inputs.  Clicking the button opens a drop-
down list from where you can choose which AES50 input channel is 
routed to that playlist track. 

By default, reconfiguring the inputs is not allowed, but this can be 
enabled in the Record Safe section of the Setup window. 

 



 
Scrolling And Zooming 

Bank select 

The SELECT buttons on the front panel of the DN9696, which change the view on 
the software interface so that it focuses on that set of 24 channels, are also 
available as software hotkeys: 

Bank 1 F1 
Bank 2 F2 
Bank 3 F3 
Bank 4 F4 

Pushing the same button again returns the software's vertical zoom so that all of 
the tracks in the project are displayed. 

When a bank of 24 tracks is focused by this method, the solo selector control 
knob  is restricted to that particular range of tracks. 

These bank select hotkeys can be customised by selecting Playlist - Stream 
Focus (in Categories) and choosing one of the four stream banks (in 
Commands).  See Hotkey setup. 

Scrolling and zooming 

Scrolling and zooming help you move around and view the playlist.  You can scroll 
a different part of the playlist to the window and magnify or diminish the part of 
the playlist already in view by zooming in/out. 

The playlist has two scroll bars, each with two zoom buttons.  The scroll bar on 
the right scrolls and zooms vertically (up/down) through the tracks so that you 
can access any that are currently hidden from view, while the bottom one scrolls 
and zooms horizontally (left/right) along the time bar. 

 
 

1. Scroll boxes — drag each box for coarse 
scrolling. 

2. Scroll bar — click either side of the scroll box 
to scroll one window width in the opposite 
direction. 

3. Up/down scroll arrows — click/hold down for 
fine scrolling. 

4. Zoom out (diminish) button — press 
repeatedly until you reach minimum 
magnification. 

5. Zoom in (magnify) button — press 
repeatedly until you reach maximum 
magnification. 

As an alternative to using the zoom buttons (above), you can adjust vertical and 
horizontal zoom levels in the Playlist menu as follows.  (These clickable zoom 



menus are also available if you hold down the CTRL key on the keyboard, while 
clicking the zoom buttons.) 

 Choose Playlist > Vertical Zoom to open a sub-menu containing seven 
zoom level options. 

 Choose Playlist > Horizontal Zoom to open a sub-menu containing 24 
zoom level options. 

Default hotkeys for zoom are the LEFT ARROW/RIGHT ARROW keys for horizontal 
zoom out/in and the UP ARROW/DOWN ARROW keys for vertical zoom in/out. 

If you have a mouse with a wheel, you can use it in the playlist to do the 
following: 

 Wheel = vertical scroll up/down (as per other applications). 

 CTRL+wheel = vertical zoom in/out. 

 SHIFT+wheel = horizontal zoom in/out. 

 There are six zoom preset buttons to the left of the bottom 
(horizontal) scroll bar, as follows: 

 The Centre on timeline button  centres the current 
timeline in the playlist.  This allows you to jump quickly 
to the current timeline if you have scrolled or zoomed in 
the playlist and the timeline is off screen, and saves 
you having to scroll or zoom. 

 A is a Show entire playlist button that fits all of the 
clips into the playlist. 

 S is a Show selected entries button that adjusts the 
zoom to fit all the selected clips (red) in the playlist. 

 1, 2, 3 and 4 are Zoom preset buttons that provide 
four preset zoom levels.  The preset zoom level 
assigned to each button can be changed by right-
clicking on it and selecting a new zoom level. 

 
The hotkeys, for the preset zoom buttons and centre display 
on timeline button are as follows: 

 ALT+1 = Zoom preset 1 

 ALT+2 = Zoom preset 2 

 ALT+3 = Zoom preset 3 

 ALT+4 = Zoom preset 4 

 ALT+5 = zoom to all (A) 

 ALT+6 = zoom to show selected clips (S) 

 ALT+C = centre display on timeline 

All of these hotkeys can be reassigned in the Zoom Presets 



category of Hotkey setup. 

 

Notes on zooming: 

 You can zoom in/out during playback, but the dotted current timeline will 
always remain in view. 

 The playlist will always stay centred on the position of the timeline. 
 Therefore, when you zoom in, it will focus on the timeline. 

 When zooming out, at the minimum zoom levels all clips are shown as 
blocks and not profiles. 

 



 
Track Colours 

Similarly to pop groups on Midas digital consoles, playlist tracks can be 'colour-
washed' for identification, as shown in the following example. 

 

To change the background colour of a track, right-click on its name button and 
then choose Colour, which will open a palette.  Click on the colour you want and 
then click OK.  Alternatively, click on the name track icon to open the 
colour/naming dialogue. 

Note: It is also possible to colour tracks via the groups. 

Colour palette 

The palette contains 16 (default) custom colours to choose from.  However, if you 
want a different colour you can create almost any colour you want in the Color 
window. 



 To create a custom colour 

1. In the palette, click Customise to open the Color window. 

2. In the Basic colors or Custom colors sections, click the colour you want 
to change. 

3. Click the colour swatch to change the Hue and saturation (Sat), and then 
move the slider in the colour gradient to change the luminescence (Lum). 

4. Click Add to Custom Colors, and then click OK. 

The new colour will appear on the colour palette. 



Clip Colours 

The colour of a clip in the playlist provides information about its properties: 

 

Green: When they are first recorded, clips with more than one channel 
are green, and all channels are grouped together. 

 

Cyan: Cyan clips are mono only.  If you ungroup a green multi-channel 
clip, it will change the colour of every channel to cyan. 

 

Red: Clips change colour to red when they are selected.  Many 
functions and operations, such as edit, nudge, delete etc., will only act 
upon selected clips.  Select a clip by clicking on it. 

 

Blue: Clips become blue to show that an edit operation on an earlier 
clip (or later one depending on mode) will move the blue-coloured clip 
as well.  This is only enabled by switching on the slip function. 

 

Yellow: Clips are yellow to show that they 'unnatural' groups.  If 
channels and clips are grouped together, where every channel is the 
same length, from the same original recording and all perfectly in sync, 
they will display as green.  If a green clip has been ungrouped, and 
some channels either shortened or offset in terms of sync, and then 
grouped again, it will display in yellow.  Likewise, any unrelated clips 
that are regrouped together will display in yellow.  There are a few 
editing restrictions that apply to yellow grouped clips. 

 



Grouping Tracks 

You can group tracks so that they can be muted, soloed, record enabled, and 
edited simultaneously. 

Stereo tracks 

The easiest way to group tracks is to stereo merge them.  When input channels 
are working as stereo tracks, it is often convenient to merge them. 

To merge a pair of tracks to stereo, right-click on either the left or right track of 
the pair in the area of the solo, mute and record enable buttons.  Then, choose 
Merge Into Stereo Stream. 

 

The stereo track now has one name button and one control each for solo (S), 
mute (M) and record enable (R). 

 

An odd-numbered track can only be stereo merged with the adjacent even-
numbered track of higher value. 

Note: When a pair of tracks are stereo merged they are recorded to a 
single stereo WAV file, which is useful for ensuring that stereo instruments 
remain locked together.  However, if the project is to be exported to Pro 
Tools, this should be avoided.  This is because Pro Tools cannot import 
stereo files directly, and must first copy them to two mono files, which is 
done automatically.  So, although the stereo file can be imported, any 
automatic grouping in Pro Tools may be spoilt. 



 
Track Groups List 

You can group tracks into multi-channel and non-consecutive groups, which is 
done via a GROUPS list.  A track can belong to more than one group, and you 
can have more than one group enabled. 

The Show/hide stream and groups lists button  (top left of playlist) opens 
the GROUPS list (left of the playlist).  This list is initially empty, except for the 
word "All"; track groups appear below this as you create them. 

 

 

 To create a new track group 

1. Press the Form New Group From Selected Streams button  (upper-
left corner of GROUPS bar).  This opens the New Stream Group window. 



 

2. In the Name for Group: field, type a name for the group.  For example, 
"Drums". 

3. Make sure that the Create from list option is selected (ticked). 

4. Click the tracks that you want in the group.  Selected tracks have a blue 
background.  You can select multiple tracks by holding down the CTRL key 
(to add to selection) or SHIFT key (to select a range) while clicking. 

5. Click OK.  The new group will be added to the list in the GROUPS bar. 

You can also create a group by manually enabling tracks and then ticking the 
Create from selected streams option. 

 To enable a group of tracks 

Click the group's name.  The track name buttons of the selected group of tracks 
remain selected (stay 'pressed in'), while the other tracks are disabled (their 
name buttons will be 'out').  Disabled tracks have a darker grey background. 
 Clicking on the word "All" enables all tracks again. 

 To enable additional groups of tracks 

To enable additional groups, CTRL+click on a group name in the groups list. 

 

When you enable/disable a group(s) the background colour of the group's name 
will change.  This shows you whether or not the tracks are enabled: 

 Blue background  All of the group's tracks are selected.  (This colour is 
dependent on your PC's Windows colour scheme.  As blue is the default, if 



you have changed your Windows colour scheme this colour may be 
different.) 

 Pink background  Only some of group's track are selected. 

Selected groups have an asterisk * to the left.  Functions that can be applied to 
selected groups are: 

 Solo group(s). 

 Mute group(s). 

 Record enable selected tracks.  (By default this is set to record enable ALL 
tracks, but there is an option in Record Safe Setup that changes the logic so that 
this record enables only selected tracks.) 

 Change the colour of selected tracks (see Track Colours). 

Right-mouse clicking on any of the five buttons at the top of the GROUPS list 
opens the following menu: 

 

 New Group  Creates a new track group.  Groups allow related tracks to 
be viewed, coloured and edited together more easily. 

 Edit Group  Lets you make changes to a previously created group. 

 Save Group  ??? 

 Delete group  Deletes a previously group for list. 

 Enable all Streams and Disable all Streams  Enables or disables all 
tracks, respectively.  For details, see Enabling Tracks. 

 Record Enable Selected Streams, Reverse Enabled/Disabled 
Streams and Activate/Deactivate Streams  For details, see the 
following section. 

 Unmute All Streams  Turns off all track mutes. 

Disabled tracks versus inactive tracks 

Disabled tracks and inactive tracks are quite distinct from each other: 



 Disabled tracks will be played.  However, they are disabled from 
functions such as editing and razoring.  Effectively, "disabled"' is the same 
as "deselected". 

 Inactive tracks will not play at all, and will not use DSP resources.  The 
waveforms of inactive tracks are displayed in grey and their buttons' 
names are orange.  ALT+click on a group name to toggle the group 
between inactive and active. 

The Playlist menu includes the following commands: Make all clips active, 
Make all streams active, and Make all enabled streams active. 

There are some common interface features for enabling/disabling and making 
active/inactive, as follows: 

 Click a track name button to switch the track between disabled  

and enabled . 

 ALT+click a track name button to switch the track between inactive 

 and active . 

 SHIFT+click on a track name button to change a range of tracks.  It 
switches the state of the tracks above that have the same state, and stops 
when it reaches one that is in a different state.  For example, with all 
tracks enabled, clicking on track 12 disables it, then SHIFT+clicking track 
38 disables all tracks between 12 and 38. 

 ALT+SHIFT+click on a track name button to switch a range inactive/active 
with the same logic. 

 CTRL+click on a track name button to enable that track and disable all the 
others.  There is no comparable inactive/active track function. 

NOTE: Although the inactive tracks function is very similar to simply 
muting a track to stop it from playing, it frees up its resources, while 
retaining its audio track.  Effectively, creating a 'virtual track'. 



Playing and Locating 

Transport Controls 

 

1. Online/sync enable 
2. Set marker/locator 
3. Rewind 
4. Fast Forward 
5. Play 

6. Stop 
7. Record 
8. Pause 
9. Current time display 

 

The transport controls are on a toolbar above the upper-right corner of the 
playlist.  However, you can also activate the play and stop commands by clicking 
within the time bar: 

 Double-click to activate play from the current position. 

 When in playback mode, click to stop playback. 

 While the DN9696 is stopped, click to move the timeline to the chosen 
position. 

 

 
The Online button enables synchronising to LTC.  When pressed, the 
DN9696 will wait for LTC timecode to start before automatically 
going into play. 

 

 
Play and stop can also be activated by pressing the SPACEBAR on the 
keyboard.  In addition, there are hotkeys for: 

 PLAY = F9 

 STOP = F10 

 RECORD = F12 

 Record Arm All = F11 

 

The fast forward and rewind speeds can be set in the Transport Controls Setup 
command of the setting up window. 

Extra Play Functions 

The Playlist menu provides some other useful play functions: 



 Play Selected Entries  Plays only the selected clips and can be used to 
quickly play one clip or several, with the rest of the playlist being muted. 

 Auto Return on: 

 Stop  Creates a temporary locator at the point where play starts. 
 When play is stopped, the timeline will jump back to that point. 

 Play  As for stop, but the timeline will only jump back to the 
locator when play is restarted. 

You can use ALT+SPACEBAR to momentarily reverse the auto-return logic, which 
enables/disables it when it is globally disabled/enabled, respectively, as shown in 
the following table: 

 Return on stop 
enabled 

Return on play 
enabled 

Off 

SPACEBAR in stop Starts playback at 
current time and 
drops marker. 

Locates to marker 
and starts 
playback. 

Starts playback and 
drops a (hidden) 

marker. 

SPACEBAR in play Stops playback and 
locates to marker. 

Stops playback and 
stays where it is. 

Stops playback and 
stays where it is. 

ALT+SPACEBAR 
in stop 

Starts playback at 
current time and 
drops marker. 

Starts playback at 
current time and 
drops marker. 

Locates to (hidden) 
marker and starts 

playback. 

ALT+SPACEBAR 
in play 

Stops playback and 
stays where it is 
(doesn't return to 

the marker). 

Stops playback and 
stays where it is 
(doesn't return to 

the marker). 

Stops playback and 
locates to marker. 

Record lock 

When recording, the Keyboard and Mouse Lock window (below) is displayed. 
 This indicates that the mouse, keyboard and most of the front panel controls are 
locked out, which is known as "record lock". 

 

 To unlock the controls 

Click the Regain control of DN9696 tick box to select it. 

 

Record lock (also known as "transmission mode") can be invoked outside of 
record.  For example, you may want to avoid a playback loop being stopped 
accidentally. 



The only way to release this mode, other than by ticking the Regain control of 
DN9696 box, is by pressing the STOP button on the front panel and holding it 
down for at least one second. 

There is a hotkey (default ALT+X), which can be customised in Transport 
Controls (Categories) and Transmission Mode (Commands).  See Hotkey 
Setup. 

 



 
Markers And Locators  

One of the quickest ways to move around the timeline is to set markers.  As 
described earlier, there are dedicated buttons on the front panel (MARKER 
section) for setting and navigating markers.  You can also use a footswitch, which 
is connected to the FOOT SWITCH socket (1/4" Jack) on the front panel of the 
DN9696.  In addition, there are a number of marker facilities in the software 
interface. 

 
The marker set button on the transport controls toolbar has the same 
function as the marker SET button (front panel) and footswitch, and will 
place a new marker at the current time. 

 

The BACK and FORWARD buttons (front panel) and the marker set function 
can be assigned in Transport - Locators (Categories) of Hotkey Setup.  The 
default settings for these are: 

Insert quick locator at current time F8 

Go to Prev Quick Locator F5 

Go to Next Quick Locator F6 

   
The first 10 markers have individual hotkeys in the same setup page.  Go to 
locator 1, Go to locator 2 etc., default to SHIFT+F1, SHIFT+F2 etc. 

Note: Markers are also referred to as "locators" in the software. 

Loop 

 A single pair of left and right markers are used for looping and region 
editing. 
  

 
When the loop button is selected (pressed in), the DN9696 will stop and 
restart playback from the  left marker when playing up to or after the  
right marker. 

The default keyboard hotkey for loop is L. 

Loop is an important feature when you are using the DN9696 to playback for a 
virtual soundcheck.  There is also a useful feature in the Locator Table that 
automatically sets the  and  markers. 

There are some hotkeys for left and right marker functions: 



Set Left Locator SHIFT+LEFT 

ARROW 

Set Right Locator SHIFT+RIGHT 

ARROW 

Go to Left Locator CTRL+LEFT 

ARROW 

Go to Right Locator CTRL+RIGHT 

ARROW 

Clear Left Locator CTRL+UP 

ARROW 

Clear Right Locator CTRL+DOWN 

ARROW 

Zoom to view whole Loop/Region SHIFT+Z 

Zoom to view around Left Marker SHIFT+X 

Zoom to view around Right Marker SHIFT+C 

 

Loop can also be set by clicking the region edit button   (Edit toolbar), which 
allows you to 'draw' a region that is bounded by the left and right markers.  For 
more information, see Region Edit. 

The zoom to view around left/right marker functions use a default zoom level, 
which can be changed in  View > Setup Window > Playlist > Playlist Display 
> Horizontal Region edge zoom level. 

Locator table 

  You can view the markers and their individual properties in a table, which 
can be seen at the bottom of the Playlist window by pressing the 'Show/Hide Text 
Pane' button (upper-right of Playlist), and then selecting the Locators tab. 

The most useful function here is the ability to Set a Loop: 

 Clicking in the Type column (left of table) on one of the marker icons will: 
a) Position the current time at that marker. 
b) Place the  left marker on top of the selected marker, and the  right 
marker on the next marker in time.  Thus, the loop bounded by the left 
and right markers will be automatically set.  (To enable Loop, press its 

button  or hotkey.) 



 Also, double-clicking in the Type column will first set the left and right 
markers for a loop, and then will start playback from that marker. 

Additionally, in the locator table you can: 

 Edit parameters by double-clicking on the field, and typing a new time, or 
selecting a parameter from a list. 

 Reorder the whole table by clicking on a column header to reorder with 
respect to that parameter. 

Marker parameters and features 

1. Once set, markers can be dragged with the mouse to reposition them.  
You can also lock markers — by default they are set to be 'moveable' but 
this attribute can be changed either in the table or from the menu that 
appears when you right-click on the marker.  There is also a set up option 
to allow markers to default to be 'moveable' or not. 
 
To make it easier to pick up a marker, if you press CTRL, the pointer will 
snap to the closest marker when you click in the timeline. 

2. Markers can be set to follow slip rules (or not).  This is only relevant if you 
are editing and using the Slip function, which is described in more detail in 
the Editing chapter.  When edits in the Playlist are causing entries 
upstream/downstream to slip, then so will the markers.  There are set up 
options to determine the default state (markers default to having slip 
disabled), but individual markers can be set to slip or not.  Hence, some 
markers can be fixed time marks, and others can mark audio events.  The 
slip state of a marker can be changed either in the table or by choosing 
the slip item from the marker's right-click menu. 

3. Multi-dimensional locators.  These are disabled by default. There are a 
number of fields in the Locator table which, by default, will report 
'unspecified'.  These are controls for multi-dimensional locators. 
 
If the Multidimensional locators set up switch of the Locators topic 
(see Locators Setup) is ticked when you capture a marker position, the 
horizontal zoom, vertical zoom and the vertical track view is captured; this 
view is recalled when you go to that marker.  There are fields in the 
Locator Table for these: Stream (Track), Vertical Zoom and Horizontal 
Zoom, where their values can be changed or disabled.  For example, you 
can set just Track View and let V- and H-zoom be unspecified if you want. 

All markers and their parameters are saved as part of the Playlist. 

 



 
Locating 

Apart from using Markers, there are a number of ways of moving the current 
timeline in the playlist: 

1. Using the time bar: 

To start playback from a specific point, double-click within the white time 
bar area at the top of the playlist or on the body of the clip at the required 
point. 
 

 
 
The mouse time display — the left of the pair of times on the left side of 
the bottom scroll bar — will show the exact time you are pointing to. 
 

 
 
Click anywhere within the time bar to stop playback. 

Click in the time bar when playback is stopped to locate the timeline to a 
new position. 

Note: Scroll or zoom out to access parts of the playlist that are not 
currently displayed (see Scrolling and Zooming). 

2. Using the time display: 
 

 

Using drag, click on any field of digits in the time display (hours, minutes, 
seconds etc.) and move the pointer up/down to increase/decrease their 
value.  The more you move the pointer the faster they change.  Release 
the mouse button to set the new value and locate the timeline. 

Alternatively, double-click on the time display.  The box that pops up 
allows you to: 



 

 Type in the timeline value, then press the ENTER key. 

 Click ZERO to locate to 00:00:00, and then click OK. 

 Click the up/down arrows to adjust the time; these nudge the 
lowest units.  To nudge seconds use SHIFT+click, and to nudge 
minutes use CTRL+click.  To finish, click OK. 

3. Using the transport controls: 

 
Double-clicking on the stop button is a quick and easy way to set 
the timeline to zero. 

 

The rewind and fast forward buttons are fixed speed, but there is 
a Fast Forward & Rewind Speed set up option in the Transport 
Controls topic (see Transport Controls Setup) to change the 
speed. 
  

4. Using hotkeys: 

 
There is a very useful default hotkey on the computer keyboard: 

 Press END to locate to the end of the last clip. 

Locating to clip in- and out-points 

 
You can move the timeline to the beginning/end of the previous/next clip 
on any enabled track by using the following hotkeys: 

 To select the previous clip, press SHIFT+COMMA (<). 

 To select next clip, press SHIFT+FULL STOP (>). 

There are also hotkeys for Locate to Selection Start and Locate to 
Selection End in the Playlist category (see Hotkey Setup).  These are 
COMMA (,) and FULL STOP (.). 

 



LTC Synchronisation 

The DN9696 has provision for reading LTC and to have the transports follow a 
source of LTC.  To enable this: 

1. Connect a source of LTC to the LTC INPUT XLR connector (right of the 
AES50 I/O connections on the rear panel of unit). 

2. In the software, choose View > Setup Window and then click LTC in the 
list of topics (see Sync Setup). 

3. In the Frame Rate section, select the frame rate that matches the 
incoming LTC's frame rate. 

4. In the Timecode Type section, select the LTC option. 

5. In the Sync Mode section, select Slave Mode.  The label on the Online 
button will change to LTC. 

6. Press the Online/LTC button to enable LTC slave and make the DN9696 
ready to read LTC (when the Online button is up, any LTC is ignored). 
 Upon reading valid LTC, the DN9696 will go into play. 

 

When LTC slave mode is enabled, (by default) pressing RECORD automatically 
operates the Online/LTC button.  This can be changed by unticking the Auto 
online when pressing record option in Record Setup.  However, if LTC is not 
being used, it is better to disable slave mode in the Sync Setup set up. 

It is also possible to enable LTC slave mode by right-clicking the Online button 
and choosing LTC slave. 



Meters 

Meters 

Each playlist track has a 20-segment level meter that displays input levels when 
the track is record enabled, or playback level when in playback. 

 

You can customise and enlarge the meters up to 64 segments, and you can also 
change the scaling and the thresholds at which the meters change colour. 

The meters are set up in the Playlist Streams (tracks) page of the Playlist 
topic. 



 

Changing the LED numbers (segments) alters the point at which the colours 
change. 

Changing the Level (dB) values alters the scaling and the level at which the 
colour changes. 

You can reduce the Top Red LED number, and that will reduce the overall length 
of the whole meter.  However, you should ensure that the Top Yellow and Top 
Green LEDs are a lower number than the one for Top Red. 

You can have up to four set ups (configurations), and each are stored in the User 
configurations section.  Click Store to store your configuration and Recall to 
recall it.  To restore the factory defaults, press Recall default. 

Normally, the numeric peak hold displays will turn red when the level goes over 
the Top Yellow value.  However, by selecting the Red peak display above 0dB 
only option, you can change this behaviour so that it only goes red when level 
goes over 0db. 



Peak hold 

The two buttons above the meters control the handling of peaks. 

 
The Peak hold mode button switches the peak hold mode.  When 
pressed, the highest peaks are held until the Clear peaks button is 
pressed. 
 

 
Clear peaks button — all held peaks are cleared, including both the PPM 
meters and the numeric displays. 
 

The default hotkey for clear peaks is the C key. 
 



File & Project Management 

File Management 

Until now the manual has dealt with the fundamental tasks of playing and 
recording, which has included the general operation of the DN9696 and 
instructions on how to make a new project and set up the disk drives.  However, 
this section will concentrate on those files that are created by the DN9696 and 
where they are stored on the hard disks. 

Files 

The two most important types of files created by the DN9696 are WAV files and 
EDL files. 

 WAV files  When DN9696 records, it stores the recordings in 96kHz, 24-
bit, uncompressed broadcast wave format (BWF).  BWF is an extended 
version of the popular WAV format that is supported by all computers. 
 BWF includes extra metadata in comparison to a WAV file.  However, the 
BWF has the same ".WAV" file extension and is fully compatible with WAV. 
 Any system that can play a standard WAV can play a BWF.  An important 
extension in the BWF header is that it can contain a timestamp, that is, 
the time position at which the audio was recorded. 
 
Each channel recorded will be saved as a separate mono BWF file.  It also 
contains information inside the file and in the filename for post-production 
or DAW systems to identify which channel name and number the file is 
associated with, and how to group the channels together. 

 EDL files  When you start the DN9696, you create a project.  The project 
file is saved as an EDL file, which describes the clips in the playlist, their 
times and the order in which they are played. 
 
When you deliver any audio files to another system for mixing, it is most 
likely that the files of major interest will be the audio files.  However, if the 
audio is being played on another DN9696, having the EDL as well provides 
a quicker way of loading and positioning all the audio files. 
 
Any edits and markers will be saved with the EDL, so that your project 
loads up the same as when it was saved. 

Non-destructive editing 

An important concept is that editing in the DN9696 is non-destructive.  Once the 
audio recording has finished, while the WAV files are being used by DN9696, they 
remain unchanged.  Any edits made will not affect the original WAV files, as these 
changes are saved in the EDL file.  You can delete a recording from the EDL, but 
it will still remain on the hard disk, and can be re-inserted into the playlist. 

 



 
Source Files Folder 

At the upper-right corner of the display there is small Source Tracks Folder 
window, which may also be referred to as the "clipstore".  This window lists all 
recordings that have been made in this project, and its main purpose is to give 
you access to the full original recordings if they have been edited or deleted in 
the main playlist.  If you import audio into the project this is where it will first 
appear. 

 

To open/close the Source Tracks Folder window, click the show/hide source 

tracks folder button . 

You can drag entries from the window into the playlist. 

You can expand a single recording to see the separate audio files (see below), 
and you can then drag individual channels to the playlist if you want. 

 

Right-clicking within the Source Tracks Folder opens a menu of clipstore 
commands as follows: 



 

 Preview  Right-clicking a clip in the Source Track Folder window and 
then choosing Preview opens the Preview window and selects the clip in 
the window.  The window contains zoom buttons in the lower-right corner, 
and there is a slider control along the bottom to position the preview 
timeline.  The Start button starts preview playback and the Stop button 
stops it.  The Time panel (lower-left corner) is referenced to the clip's 
timestamp, that is, the timecode at which it was recorded. 

 

 Drag to multiple playlist streams  Select (tick) this command if you 
want to drag multiple clips from the clipstore to the playlist in parallel 
(each clip on a separate track).  Otherwise, the multiple clips will be 
dragged in series (one after the other). 
 
Tick this option if you are dragging a selection of separate mono channels. 



 Import source track(s)  Allows you to import audio files from another 
project into the current project.  For example, if you want to play 
recordings made in a different project on an earlier night.  This command 
links to the files in their original disk locations.  Therefore, the import 
process will be fairly quick, as the DN9696 only has to log the files. 
 

This command is also available on a button  on the Edit toolbar. 

 Copy and import source track(s)  This command is similar to the 
Import source track(s) command, although it makes a copy of the files 
when importing.  As this may take some time to complete there is a 
progress display as the files import. 

 Copy non-project audio locally  If you have used the Import source 
track(s) function to link to files in their original location, you can use this 
function to copy them to the current project's audio directory. 

 Cleanup unused audio  This function will delete audio files — quite 
possibly permanently.  The files are sent to the Recycle Bin (in 
Windows).  However, if there is not enough space for extremely large files, 
the deletion will be permanent. 
 
When you select this option, DN9696 will delete files that are not being 
used in the current playlist. 

 View/edit track metadata  Allows you to edit the metadata that is 
included in the audio files. 

 Re-create profile  Allows you to manually re-build the profile for one or 
more clips. 
 
A profile is the name for the graphic waveform that is displayed on each 
clip in the playlist.  The profile is built as the audio is being recorded and is 
saved to a small file alongside the audio files, so that waveforms can be 
displayed quickly. 

 



 
Disk Drives 

The DN9696 includes internal drives with sufficient storage for up to nine hours of 
96 channel recording, and so can be completely self-contained.  A brief 
description of the disk drives supplied with the DN9696 and how to use external 
mirror drives is included in the Quick Start section at the beginning of this 
manual. 

Mirror drives 

You may want to add mirror drives to the DN9696 because they: 

 Provide a safety backup copy of the audio in case of a drive failure. 

 Allow you to quickly remove a full set of recordings to pass on to someone 
for mixing, some other form of post-production or archiving. 

If more than 48 tracks are being recorded, two external mirror drives are 
required. 

External drives should be of fairly high performance, at least 7200 rpm spin 
speed, and with either an eSATA or FireWire 800 interface. 

If you are using two drives they should both have the same interface (eSATA or 
FireWire 800).  Do not mix them, as the standard method of drive selection will 
not allow it. 

Ideally, you should connect the pair of mirror drives before starting up the 
DN9696.  You can then choose those drives when creating the new project. 

Disk information panels 

The lower-right corner of the screen displays the two disk drive information 
panels.  These display key information about the disk drives, and if there is a 
problem, the panel will flash.  If the whole right panel is hidden, any disk error 
will cause it to open.  To open/close the panels, click the show/hide source tracks 

folder button . 



 

The front panel INTERNAL HDD and EXTERNAL HDD LEDs provide basic 
feedback for the status of each hard drive. 

The remaining disk space is always expressed as an amount of time in the Time 
Available field, and is based on how many channels are in record or that are 
record enabled. 

You can set the Low Disk Space Warning Threshold (default is 15 minutes) in 
the Record Setup window.  Choose View > Setup Window, then click the 
Record topic.  The record set up options are shown on the right of the set up 
window.  In the example shown above, a primary drive has gone below the 
threshold set for Time Available. 

The drive letters being used are also displayed in the disk information panels. 
 You can change the drive locations after you have created the project by using 

the ellipsis button .  This opens a browser from where you can choose which 
disk drive(s) to use for the primary or mirror recordings.  However, this is not the 
recommended method of allocating disk drives — it is safer and tidier to choose 
them when you first create the project. 

AES50 1 & 2 and AES50 3 & 4 

For recordings over 48 tracks, two primary disks and two mirror disks should be 
allocated.  The DN9696 display is split into two 'units'.  Each unit uses separate 
hardware resources and records to separate primary and mirror drives. 

It keeps things tidier if you split the number of tracks approximately in half 
across the two units.  For example, if you want to record 50 tracks, record 25 on 
AES50 1 & 2 and 25 on AES50 3 & 4.  If you split them 48:2, that is, with 48 on 
AES50 1 & 2 and 2 on AES50 3 & 4, AES50 3 & 4 will not be working very hard! 
 Although there is not really a problem with this — one unit and disk can easily 
cope with 48 tracks of recording — it may cause small practical difficulties.  This 
is because one pair of disks will be filling up much faster than the other, thus 
reducing your maximum record time. 

Tip: You can increase the overall available recording time by splitting 
tracks evenly across two disk drives.  If you are recording 48 tracks, 
splitting them equally across AES50 1 & 2 and AES50 3 & 4 (that is, 24 
tracks each) will make it is possible to achieve an internal recording time 
of approximately 20 hours. 



 



 
File Naming 

The centre panel on the right of the display is used for naming the recordings.  To 

open/close this panel, click the show/hide source tracks folder button . 

 

The diagram above shows the default setting, but this can be customised to add 
or remove fields.  The DN9696 always includes metadata (see Metadata) in the 
file, and this file naming area is also used to place metadata in the file, hence the 
field names. 

You do not have to type anything! 

When you press RECORD the files recorded will be named according to this 
section, but the TAKE number always increments automatically.  So, even if you 
were to manually force a duplicate take number, the DN9696 would append its 
own take value to the filenames. 

To help identify the files, you may want to type something into the PROJECT 
field.  All the file names will begin with this text. 

You can edit these fields during recording and they will be updated.  For example, 
to change the name or take number, or to add notes. 

By default, the individual files will be named from these metadata fields according 
to a scheme that is friendlier to Pro Tools (see Work Flow - Pro Tools).  Pro Tools 
is able to interpret the meaning of the filename and use the metadata inside the 
files. 

How the file names are constructed 

Using the example in the following diagram, the file names are constructed as 
detailed below. 



 

The 96-channel grouped clip in the playlist is called "DN9696_001_012", where: 

 "DN9696" = text entered into the PROJECT field. 

 "001" = name/number in the SCENE field. 

 "012" = number in the TAKE field. 

In the diagram above, each individual channel has a slightly different name, 
which includes the track name and number.  In the first entry: 

 "acoc" = track button name text (as shown to the left of the playlist 
section). 

 "18" = track that this was recorded on. 

The track name is always included in the filename as a four-character 
abbreviation.  So, what was actually typed was 'acoustic'.  Similarly, track 24 was 
an 'Alto Sax', and tracks 20 and 21 were 'BVocal1' and 'BVocal2', respectively. 
 The full track names are included in the metadata.  However, Pro Tools can only 
accept four characters in this part of the filename if it is to group the files 
correctly with their multi-track partners.  For details of how to rename tracks, see 
Playlist Controls. 

Note: If the recorded files are intended for use within a Pro Tools system, 
we recommend that you keep the default settings. 

 



 
Metadata 

Metadata is automatically inserted into the files when you are recording.  So, 
what is metadata? 

In this context we are using the word metadata in a fairly narrow sense to mean 
non-audio data.  There is already plenty of automatic metadata in a DN9696 
audio file, such as sample rate, bit rate, timestamp etc. 

The BWF format file has a number of extra fields that can (reasonably) be freely 
used for user data.  For example, information and notes about the recordings that 
will be useful to someone further down the production chain to help identify the 
recording. 

The metadata function of the DN9696 uses the BWF Description field, which is 
primarily aimed at film and TV location recording and is commonly used to store 
metadata in these applications.  Because of the common usage, other 
professional audio systems such as Pro Tools are able to read this metadata. 

Optionally, this metadata may also be included in an iXML chunk in the file. 
 There is a tick box for Record iXML Chunk in the Record set up page to enable 
this.  See iXML implementation chart. 

Record set up 

The set up window has a Record topic, which has switches to enable the 
functions associated with the metadata and mirroring features. 



 

Metadata template file 

The Metadata template file section has Save and Load buttons that allow you 
to save and load different metadata set-ups.  Having customised the metadata 
fields (see Customising Metadata) that you want to save to recordings, you can 
save the configuration as a template.  The DN9696 has two templates, which will 
set you up for standard operation: 

 record_metadata_template.xml (general template) 

 us_record_metadata_template.xml (US template) 

The only difference between the templates is that the one with a "us" prefix is set 
to label scenes alphanumerically (with a number and letter), for example, "10C", 
whereas the general template only labels scene numerically. 



Incrementing the scene number 

Although it may not be necessary to include and maintain scene numbers in the 
files, "Scene" is a standard metadata type that is supported by other 
workstations.  So, it could be used as part of an identification scheme. 

If you are using the scene field, there are three hotkey functions to increment 
the scene number as follows, which are set up in the Record Metadata category 
of Hotkey Setup. 

Advance Scene Letter 
Advance Scene Number 
Advance Scene Number, Reset Letter 

These functions are designed to be used with the two different scene labelling 
schemes.  With the alphanumeric US scheme, you need both the Advance Scene 
Number and Advance Scene Number, Reset Letter hotkeys, whereas the 
numeric-only scheme only requires the Advance Scene Number hotkey. 

All three hotkeys reset the 'take' number to 1 when the scene number is 
changed. 

 



 
Customising Metadata 

Metadata is customised via a window (a typical example is shown below), which 
shows all of the available metadata fields.  There is a section for each metadata 
field that contains a Field box for the metadata's name, a Value box and a 
Position selector. 

 

Note: The BWF Description field that is used to store metadata with the 
audio is restricted to 256 characters.  So, if you use labels or data that are 
too long, some data will be truncated.  However, the iXML chunk has no 
such restriction. 

To open the metadata fields window, make sure the source tracks pane is 
showing — if necessary press the Show/hide source tracks pane button — 
and that the Record Metadata panel is maximised.  Then press the View All 
Metadata Fields button in the Record Metadata panel.  The window will open, 
allowing you to edit metadata fields and add new ones. 

The Position determines how the fields are ordered in the main record metadata 
window.  Note that you must set a contiguous sequence of position numbers; the 
DN9696 will warn you if you miss any out. 

New and Delete buttons allow you to make a new metadata field and delete the 
selected one. 

In the example above, a new field called "MICS" has been created.  This is a non-
standard metadata field, and has been included to illustrate that the fields can be 



freely named.  In this example, this field describes the microphones used and on 
which channel of the recording they are assigned to. 

Tip: It is worth using useful and recognisable terminology in these fields, 
as other people may have to refer to it later and understand it.  For 
example, in post-production. 

 

In the typical example of the field editor window (above), note that there are 
some fields with no position displayed.  Although the position exists, and is 
included in the BWF Description, it is simply not shown on the screen. 

Note: ORIGINATOR is a special field, and will be placed into the 
Originator field of the BWF. 

The above example will produce a BWF Description field containing the following: 

sSCENE=32 

sTAKE=14 

sNOTES=a bit loud 10:12:42 

sNAME=TTW 

sMICS=1 Stereo L 2 Stereo R 3 Stand  4 Lav 5 Camera 6 Radio 

Metadata right-click menu 

Right-clicking in a metadata field will open the following menu, which allows you 
to set the behaviour of the data in that field. 



 

 Cut, Copy, Paste, Delete and Select All are the standard Windows 
commands. 

 Font  Lets you choose the font for display in the Record Configuration 
window. 

 Font (all fields)  Lets you choose the font for display in all fields. 

 Numeric only  Sets the field's value to a number, and 
increment/decrement arrows will appear next it. 

 Boolean  Uses a true or false statement to control the field. 

 Auto increment  Increases a numeric value by one every time record is 
entered. 

 Multiline  Allows a carriage return/line feed (ENTER) character to be used 
in the value.  It has been noted that users find it difficult to avoid pressing 
the ENTER key to confirm the data entry, even though it is not necessary 
in this case, as the metadata is updated continuously.  So, switching 
Multiline off (unticking) will ignore any ENTER key presses and thus 
prevent new lines in metadata fields. 

 Default value  Lets you set the initial value for the field. 

 User editable  Allows you to edit the value (or disable editing). 

 Add to track name  Only fields with this value ticked will be included in 
the track name when Construct track names from record metadata is 
ticked in the Record set up page.  In the previous example the file name 
"TTW_032_014"' will be produced if the NAME, SCENE and TAKE fields 
are added to the track name. 

 Add label to track name  When Add to track name is also selected the 
track name will also include the field name.  For example, you could make 
the track name "TTW_SCENE032_TAKE014"' by ticking this for the SCENE 
and TAKE fields. 

Metadata templates can be saved/loaded from the Metadata template file 
section of the Record set up page. 



iXML 

If you create custom metadata fields that don't exist in the iXML specification, 
they will appear in the USER part of the iXML chunk.  For example, as the MICS 
field (shown in the example above) is non-standard, it will appear as "MICS=1 
Stereo L 2 Stereo R 3 Stand  4 Lav 5 Camera 6 Radio" in the user field in the 
iXML.  See the <USER> iXML Master Tag in the iXML Implementation Chart. 

 



Editing 

Editing 

In addition to its recording and playback facilities, the DN9696 provides a fast 
and intuitive interface for editing.  Whether you require a simple reordering, top 
and tail, or something more detailed and at an audio sample level, the DN9696 
includes some of the most powerful editing tools. 

The DN9696 has four basic editing techniques: 

1. Moving, copying and pasting of clips to re-order the playback. 

2. Simple cut-and-splice editing in the playlist, making 'razor-cuts' just as 
you would on tape.  This creates separate clips, so that unwanted material 
can then be removed. 

3. Playlist editing allows you to make and adjust edits by altering the 
beginning and end of any clip, as well as creating fades. 

4. Region editing.  Unlike the other three editing methods, which are clip-
based, region editing is useful for cutting or copying areas that haven't 
been defined as clips.  For example, you can use region editing to remove 
a complete section of the playlist across all tracks. 

Clips 

Clips, also known as "playlist clips", are distinct from the source files that have 
been recorded.  When you drop into record and then stop you will see an entry in 
the playlist that has up to 96 channels — this called a "clip".  The following pages 
will show you how to use the razor tool to cut this clip into two separate clips (but 
still referring to the same original files — remember that editing is non-
destructive).  You can ungroup the separate channels of this clip and then you 
will have 96 separate clips. 

Clips have many properties.  Every clip has a fade in and fade out, which defaults 
to being very short (to avoid zero-crossing glitches), but can be extended.  The 
length of clips can be altered, as can the level.  And all this without changing the 
original audio file. 

You will probably not be expected to produce a complicated edit with the DN9696, 
although it is possible.  However, it may be useful to be able to move clips around 
the playlist and to top and tail entries to tidy up a section that you are using for a 
virtual soundcheck. 

 



 
Selecting Clips 

To perform any function on a clip, it needs to be selected first: 

 To select a single clip: Click on it.  It will turn red to show it is selected. 

 To select more than one clip: SHIFT+click the clips one by one to add 
them to the selection. 

 To select adjacent clips: Use drag to draw a box around the clips you 
want.  Be careful not to start the box on a clip that is already red, or you 
will find you are moving it! 

 To select all the clips in the playlist: Choose Edit > Select All. 

 To select clips on all tracks in a time range: Hold the ALT key while 
moving the mouse — clips touched by this range will be selected.  This is 
probably only useful if you have ungrouped a multi-channel clip, because 
all channels of a grouped multi-channel clip are always selected together. 

 To deselect individual clips: SHIFT+click on them. 

 To deselect all clips: Press ESC. 

NOTE: Selected Clips are red, which indicates a warning!  Once selected, 
it is quite easy to move clips by mistake, so always deselect them when 
you have finished. 

 
There are several hotkeys for selecting/deselecting clips: 

 SHIFT+COMMA (<) = selects previous clip 

 SHIFT+FULL STOP (>) = selects next clip 
 CTRL+A = selects all clips 

 ESC = deselects all clips 

Total time of selected clips 

There are two red time displays underneath the playlist (left of the horizontal 
scroll bar and zoom presets).  The left one shows the time position of the mouse 
pointer.  While the right one shows the total time of the selected clips; this figure 
includes any silent gaps between clips. 

  

 



Renaming Clips 

To rename a clip, right-click on the clip you want and then choose Edit entry 
name.  Type the new clip name, and then press CTR/LF. 

 

 
Press Y on the keyboard to rename the currently selected clip.  This hotkey 
will only work on a selected clip that is currently displayed on the screen. 

 



Cut, Copy and Paste 

 

You can move, copy and delete clips in the playlist of the DN9696.  To do this it 
has four cut, copy and paste function buttons on the Edit toolbar or you can use 
the playlist's right-click menu.  These techniques are similar to the way that text 
can be manipulated on a word processor. 

When clips are cut or copied, they are pasted into a temporary store, or "paste 
buffer".  Each cut or copy operation replaces the current contents of the paste 
buffer with what you have just cut or copied. 

Cutting and removing clips 

 
Select the clip(s) and then press Cut entries to 
buffer. 

Note: To remove a clip from the playlist without it being loaded into the 
paste buffer, either select it and then press DELETE or right-click on it and 
choose Delete entry.  This is useful if the paste buffer already contains 
something that you want to paste in later. 

Copying clips 

 
Select the clip(s) and then press Copy 
entries to paste buffer. 

Pasting clips 

Once you have loaded the paste buffer by cutting or copying, you can then paste 
its contents into the playlist: 

 
Press Paste to cursor.  When you move the pointer over the playlist 
tracks, you will see that its icon has changed to a reel of tape with a cross 
indicating where the in-point of the clip(s) will be positioned.  The mouse 
time display (far left) shows the exact EDL time.  Click to paste the clip(s) 
into the playlist. 
 

 
 

 
This function is available as a keyboard hotkey (SHIFT+V). 

To cancel pasting and drop the paste symbol from the pointer, press the Paste to 
cursor button again or right-click. 

 
Pressing the Paste to current time button places the contents of the 
paste buffer into the playlist at the current time.  Normally, this will be 



with the entry's start time to the current time.  The paste item in the Edit 
menu has the same function. 

Note: Multiple clips cut or copied from the playlist will be pasted back with 
the same time and track relationships between them.  After pasting, the 
paste buffer is not emptied, which allows you to paste further copies as 
many times as you want. 

Pasting whole EDLs to another EDL 

The paste buffer can be loaded with an entire playlist that has been previously 
saved.  On the menu bar, choose File > Load to paste, which opens an Open 
EDL box.  Select the playlist you want, then click Open. 

The paste buttons will be active, so you can immediately paste the selected 
playlist into your current playlist.  This function is very useful for compiling work 
from other recordings and separate projects. 

 



 
Moving Clips 

There are a number of ways you can move clips around the playlist, such as: 

 Using cut and paste (see Cut Copy and Paste). 

 Selecting entries, and then dragging them to a new location or track.  The 
playlist will scroll automatically if you move the entry near its edges. 

Note: While you are moving the entry, the mouse time display will 
change to show the start time you are about to set when you drop it. 
 Red is a warning!  Once selected, it is quite easy to move entries by 
mistake, so always deselect them when you have finished. 

 Nudging them by small amounts left/right (earlier/later in the EDL) or 
up/down (to different tracks without changing in and out times and so 
maintaining sync) using keyboard hotkeys. 

You can also move entries when using playlist editing mode. 

You cannot move clips to a different track if they are already as wide as the full 
number of channels of the playlist, that is, a movement will not be allowed if it 
involves losing audio tracks. 

 



 
Razor and Scissors 

 
Pressing the razor button divides all clips into two at the timeline position. 

 
Whereas the razor button always cuts at the timeline, when you press the 
scissors button, the pointer will change to a scissors icon with a cross-hair 
to show the exact cutting point (and this time is displayed in the mouse 
time display at the bottom of playlist).  You can then make a freehand cut 
anywhere in the playlist.  This is useful if you can see exactly where to cut 
from the waveform profile. 

Note: When using the razor, if there are entries at the cut point on other 
tracks that you don't want to be cut, disable those tracks first by pressing 
the Track enable button.  The scissors function cuts only on the stream 
under the pointer, providing a useful alternative to the razor if working 
only on one stream; unless some of the tracks or the selected track is part 
of a group. 

 CTRL+scissor-cutting cuts across all enabled streams at the mouse time. 

 ALT+scissor-cutting cuts at the current (timeline) time — rather than at 
the mouse time — on the stream under the pointer. 

 CTRL+ALT cuts on all streams at the current (timeline) time, which is the 
same as using the razor. 

 Right-clicking while the scissors are selected disables them and returns the 
pointer to its normal 'select' mode. 

Glue 

The glue button  'heals' razor or scissors cuts.  This will work if clips have 
retained their original sync relationship.  For example, if you make a razor cut 
and don't move either clip, you can use glue to 'stick' them back together again. 
 If you make two razor cuts and delete the centre clip, as long as you don't move 
(or slip) either of the remaining clips, you can glue the cut to regain the deleted 
section.  However, if you razor and move one of the clips, you can't glue them 
back together again. 

Default crossfade 

Whenever a razor or scissors cut is made, a tiny crossfade is produced.  All clips 
in the DN9696 have a fade in and fade out, as defined by the Default Crossfade 
setting, which is usually 10ms. 

 



Enabling Tracks 

Enabling/disabling tracks provides a means of separating some tracks from others 
for certain editing functions, and of allowing you to select a track or sets of tracks 
that you are working on without affecting others. 

 
 
Disabled tracks have a darker grey background than enabled tracks.  When a 
track is disabled it will play back as usual, but is not affected by slip (when 
enabled) or razor functions. 

 The track name button displays the track name.  Clicking on it 
enables/disables its track for the editing and slip operations, as 
described in the following sections.  The playlist starts with all tracks 
enabled.  SHIFT+clicking this button acts on the tracks above it that are 
all at the same status, which is similar to using the SHIFT key to select 
items from a list in most Windows applications.  Additionally, there is a 
'reverse' enabling function; CTRL+clicking the track button enables that 
track and disables all the other tracks. 

Razoring multi-channel clips 

If you razor a grouped (green) multi-channel clip when one or more tracks are 
disabled, the razor cut will not be allowed (there will be an error message). 

If you want to razor cut some tracks to edit them, but leave other tracks 
continuous, you must first ungroup the multi-channel clip so that it becomes 
multiple mono clips. 

 



 
Undo And Redo 

Having moved clips around the playlist, you may decide that you preferred them 
the way they were. 

 
The undo button reverses the last change that you made to the playlist. 
 Pressing it again reverses the change before that, and so on, stepping 
back through the history of your actions.  There are up to 50 levels of undo 
available. 

 
Redo steps forward through the action history, if you have used undo too 
many times. 

 

Undo and redo are also available on the Edit menu, which also gives a description 
of the operation to be undone or redone. 

 
These functions are also available as keyboard hotkeys: 

 CTRL+Z = undo 

 CTRL+Y = redo 

 



 
Snapping Clips 

There are a number of methods by which you can position clips automatically. 

Remove gap (butt) 

 
The Remove gap button allows you to butt a selected clip up against the 
previous clip on a track.  The start of the selected clip's fade-in will be 
changed to coincide with the start of the preceding clip's fade-out. 

 
This function is also available as a keyboard hotkey (B). 

Snap to cursor 

This is a useful simple tool for synchronising clips.  Right-click on the clip you 
want to move and choose either Snap entry in point to current time or Snap 
entry's end to current time.  The entry will jump to a new position with either 
its in- or out-point at the current timeline. 

 
With a single clip selected, these functions are also available as keyboard 
hotkeys: 

 I = snap entry in-point 

 O = snap entry's end 

Slip 

Slip is a useful function for keeping clips in sync with each other. 

With the slip function on and with a clip selected, other clips on enabled tracks 
will turn dark blue and will be moved automatically with the selected clip as 
follows: 

 Moving a clip using drag, using remove gap, or by using any editing 
functions will cause the slipped clips to move with it. 

 If right slip is selected, removing a clip from the playlist causes later clips 
to be brought forward by an amount equal to the selected clip's duration. 
 This means that removing a clip between two cuts in continuous audio will 
automatically remove the gap that would otherwise be left. 

 If right slip is selected, pasting a new clip into the playlist causes clips 
after it to be moved back by an amount equal to its duration, that is, they 
make room for the new clip. 

Autoplace 



The autoplace function provides facilities to accurately 'snap' clips with reference 
to particular objects in the playlist and/or the start or end of the clip. 

Autoplace can be accessed either from the Autoplace option of the Status 
Display (bottom of screen) or by using hotkeys, if configured.  To configure 
autoplace to appear in the Status Display, see General Setup.  The hotkey 
functions are enabled in the Playlist - Autoplace category of Hotkey Setup. 

There are ten different autoplace modes, which can be selected by right-clicking 
on the Autoplace section of the Status Display (or by pressing the relevant 
hotkey, if assigned). 

 

Off Switches autoplace off.  You must set a mode first — once 
a mode is set, double-clicking on the status display will 
switch autoplace on/off and retain the mode. 

Butt Autoplace a clip to butt up to the previous one on that 
stream.  The start of its fade-in will coincide with the start 
of the previous clip's fade-out. 

Gap Autoplace a clip with a preset gap separating it from the 
end of the previous one.  The gap can be set in the Playlist 
section of the set up window, displayed from the View 
menu. 

Sync Autoplace a clip to the sync position at which it was 
originally recorded. 

Hot N/A. 
In-now Autoplace a clip with its start at the current time. 
Hot-now N/A. 
Fade In end-now Autoplace a clip with the end of its fade-in at the current 

time.  This is only useful if you have created a long fade on 
a clip. 

Original Autoplace a clip or group of clips at their original EDL time. 
 Thus, when used in the same EDL, an entry will snap to 
the same time (although you can move it up/down a 
stream, as with nudge for example).  Although not that 
useful in the DN9696, this acts as a 'lock' to stop you 
changing the position of a clip if sync is important. 
 

Note: There are hotkeys (unassigned by default) to 



Lock All Streams and its partner Unlock All 
Streams, which provide a more effective way of 
locking clips in place. 

Fade Out end-
now 

Autoplace a clip with its end point at the current time. 

Snap to Quantise N/A. 

 



 
Grouping Clips 

You can group and ungroup clips. 

When you create a multi-channel recording the playlist will contain a grouped clip 
of up to 96 channels high that can be ungrouped to allow you to manipulate 
individual channels.  When you ungroup the recorded clip you will have up to 96 
separate cyan (mono) clips.  You can change one channel and then regroup them 
to form them back into a single clip. 

Although you can select multiple channels and move them as one, it is usually 
more convenient to have all channels of a single recording grouped as one entry. 

Any number of clips may be grouped together, so you can group multiple 
recordings or even segments from different recordings.  They will be drawn as a 
single block in the playlist, which can be renamed and edited as if it were one 
clip.  This is useful, for example, if you are repeating operations on the same 
group of clips, or to avoid accidentally undoing edits. 

 
Select the entries you want to group and then press Group selected EDL 
entries. 

 

Tip: If you need to select many clips, it may be easier to select all the 
clips in the playlist and then deselect the ones you don't want.  Do this by 
choosing Edit > Select All (or press CTRL+A on the keyboard) and then 
deselecting entries by pressing SHIFT+clicking on them. 

 
A group can be broken down into its component parts by selecting it and 
pressing the ungroup button. 

 
When a clip or group is selected, these functions are also available as 
keyboard hotkeys: 

 CTRL+G = group 

 CTRL+U = ungroup 

When editing a group clip, you will only be allowed to edit the starts and ends of 
the clip, and will not be able to perform an edit that would break any internal 
edits. 

 

A 'natural' group clip — that is, one whose tracks were recorded 
together — is displayed with green waveforms. 

 

'Unnatural' groups — that is, those made from segments from multiple 
disparate recordings, or even one made from a single recording, but 
whose channels may have been edited or moved in some way before 
being regrouped — are displayed in yellow. 

Expand selected clips 



When multi-channel clips are ungrouped and the individual channels are 
separated, there is still a 'family' relationship and the DN9696 knows which files 
belong together and their channel order. 

Expand Selected Clips will expand the channels of a clip and change its channel 
width to be the full number of channels that were recorded together. 

Caution: 
Be careful when using this function.  If you select 96 ungrouped tracks at 
the same point in time  and use expand, it will produce 96 separate 96-
track clips, that is, each of the 96 mono clips will expand to a 96-track 
clip. 

 



 
Quick Edit 

There are functions to move the start or end of a clip to the current time, which 
can provide quite a simple way of top-and-tailing clips without going into playlist 
edit. This is the equivalent of three separate actions: 

1. Making a razor cut to mark the start of a new clip. 

2. Selecting the top that you wish to remove. 

3. Deleting the remnant clip. 

These functions are only available as hotkeys and are found under playlist section 
of Hotkey Setup: 

 Entry in-point to current time (default is SHIFT+I). 

 Entry out-point to current time (default is SHIFT+O). 

 Entry hot-spot to current time (default is SHIFT+K). 

Note: A hot-spot is an extra reference point inside a clip, and there are 
some autoplace functions that allow you to place clips with reference to 
the hot-spot. 

These act on a single selected clip in the playlist and will move the clip's in-point, 
out-point or hot-spot to the current time cursor, without slipping the audio.  If the 
current time is positioned outside the clip, the clip will be extended to that new 
position (if enough source audio exists). 

Note also that this works during record.  Pressing the 'Out' key when recording 
will finish the clip that was in record, and start a new clip, which automatically 
becomes selected in preparation for a new 'Set In/Out' action.  Pressing 'In' 
during recording moves the in-point of the 'growing' clip.  However, this does not 
make a new audio file; it is similar to (but perhaps a bit more elegant than) the 
method of razoring to split clips during recording.  To smooth the operation of 
these functions during record, you should set up the Auto-select recording clip 
on entering record option (under Playlist/Playlist Entry Display).  This will save 
you having to click on the clip that is 'growing' in the playlist. 
 



 
Adjusting Clip Levels 

Once a recording has been made, it will play back at the same level at which it 
was recorded.  However, it is possible to apply a level change at a clip level. 

Adjusting the level of single/multiple clips 

To adjust the level of single or multiple selected clips, select Adjust level of 
selected clips from the playlist menu to open the Adjust level of selected 
clips window (shown below).  This window allows you to make an absolute or 
relative change to the level of all selected clips.  To change the level, type an 
offset value in the Offset (dB) field or click the up/down buttons. 

 

Normalising clip levels 

The normalise function automatically adjusts clip levels so that the maximum 
peak in that clip reaches a specified level (set by the user).  To use this option, 
select the clips that you wish to normalise and then open the Normalise clip 
levels window from the playlist menu. 

 

To set the peak level, type in the value in the Peak level section or click the 
up/down buttons, and then press OK.  The DN9696 will analyse the clips to find 
the highest peak, and will then lower or raise the level accordingly.  The time 



taken to perform the normalisation will depend on several factors and will vary 
from clip to clip. 

There are two modes to choose from: 

 Each clip independently normalises each clip independently — which 
also applies to the individual clips inside (yellow) group clips — and so the 
peak level will be found for every clip, and every clip may have its level 
changed by a different amount. 

 All clips as a group normalises the group as a whole — the peak level 
will be found in the single loudest clip, and thus all clips will have their 
level raised or lowered by the same amount. 

 



Playlist Editing 

Playlist Editing 

In playlist editing mode, when a clip is selected in the playlist its in- and out-
points can be freely adjusted.  Playlist editing has the following uses: 

 You can top-and-tail recordings to remove unwanted audio at the start or 
end of the performance. 

 After making a razor or scissors cut (see Razor and Scissors), you can use 
playlist editing to remove (or repeat) material at the edit point by 
'pushing' the preceding clip into its out-point, and doing the same with the 
following clip and its in-point.  Instead of moving the out-point as you 
would if you were just trimming the tail, the rest of the clip moves through 
the stationary edit point.  The initial razor cut doesn't even have to be that 
accurate, as the adjustment will fine-tune the edit. 

To use playlist editing: 

1. Activate playlist editing mode by clicking the Playlist editing mode 

button . 

2. Click the clip that you want to adjust.  It will turn bright red. 

3. Depending where you position the pointer over the clip, the pointer icon 
will change shape to show you which segments of the clip are going to 
move as follows: 

Cursor Area Operation 

 In-point Fade-in moves 

 In-point Body and fade-out move 

 Main body Whole entry moves 

 Out-point Fade-in and body move 

 Out-point Fade-out moves 

 Main body while 
pressing CTRL 

Moves the body of the entry, but leaves 
the in- and out-points where they were 
  

4. When the pointer's icon is the one you want, drag over the clip profile to 
move the audio or edit point.  When you release the mouse button, the 
edit adjustment is done. 

Note: Whether previous or subsequent clips move when you 
release the mouse button will be determined by whether you have 
selected a slip mode (see Snapping Clips). 

Note: The time display in the transport controls will show you the 
time of the in- or out-point being adjusted and this (or the new 
duration) will appear alongside the clip on the track.  When moving 
the whole entry the track display shows the in and out times. 



5. To listen to the edit, play it back as normal. 

In practice, playlist editing is quite quick and easy.  Try it out to familiarise 
yourself with the functions and what they do. 

 



Fades And Crossfades 

Every clip in the DN9696 has a fade at the start and end.  Usually, this is very 
short (the default length and shape is set in the Default Crossfade Setup page) 
and its main purpose is to smooth the beginning and end of the audio clips, and 
to avoid the common digital audio phenomenon of 'zero crossing glitches' if the 
transition from absolute silence to the presence of audio is too quick. 

There are four more pointer graphics that let you increase the length of the fades 
at the in- and out-points by dragging out the start or the end of each fade. 
 Overlapping them will create crossfades. 

If you press CTRL while moving the pointer over the edit point, the pointer's icon 
will change shape accordingly to indicate the following: 

Pointer Operation 

 Start of the fade-in 

 End of the fade-in 

 Start of the fade-out 

 End of the fade-out 
 

The type of fade curve can be altered by pressing SHIFT+ALT for coarse changes 
or ALT for finer adjustments, as you move the pointer across the edit point: 

Pointer Operation 

 Fade-in shape 

 Fade-out shape 



 
Multi-track Editing 

In addition to adjusting the edit points and fades of a single playlist entry, you 
can also apply these functions to: 

 Two entries on a single track  A group clip (that is, a yellow clip that 
contains a number of edited entries) is considered to be a single entry, 
and only the start and end of the group clip can be edited, and thus not 
the internal edits.  In most situations, when you are editing two clips per 
track, you are interested in the edit point between them. The clip on the 
left is the 'outgoing' clip and the one on the right is the 'incoming' side of 
the edit. 

 Entries on multiple tracks  Even though they may (or may not) be 
grouped together into group clips, by selecting them together you can still 
edit them simultaneously, just as if they are grouped. 



 

When two entries on a track (or two entries on any number of tracks) are 
selected when playlist editing is enabled, the following functions are available to 
use on the pair: 

 The standard playlist edit (PLE) functions for in- and out-point editing. 

 Fade lengths and fade shapes, as above. 

In addition, you alter the crossfade as follows: 

 The crossfade between each pair of entries (that is, the out-point of the 
first entry and the in-point of the second) can be moved to change the 
position of the crossfade — that is, changing the edit point to be 
earlier/later without changing the timing relationship between the two 
entries. 



 The length of the crossfade can be adjusted using CTRL+drag when the 
pointer is over the edit point. 

 The crossfade shape can be adjusted using ALT or SHIFT+ALT. 

 



Selecting Entries 

Some rules apply to determine how entries are edited together.  Clips don't have 
to be grouped into a single multi-channel clip for them to be edited 
simultaneously. 

Track enabling and grouping 

Playlist edit (PLE) only works on clips that are on enabled tracks, and so can 
operate in conjunction with the track grouping functions that provide quicker 
track enabling/disabling. 

Selecting entries 

If the selection has no more than two clips on each track, it is assumed that you 
are working on the edit point between the pairs of clips.  However, if there are 
more than two clips on any track, what constitutes the outgoing and incoming 
clips is impossible to predict, so playlist editing is not be allowed. 

Clip selection across all tracks 

ALT+dragging horizontally selects all clips in the highlighted region when you 
release the mouse button.  Thus, you can select tracks without viewing them. 
 This is similar to the 'box selection' method (below), but works across all tracks. 

Box selection 

While using drag to enclose a selection, a box is created.  When you release the 
mouse button the entire entries are drawn in red. 

Note: When using the ALT or box selection methods, the clip in- or out-
points enclosed by the region/box determine which ends of the clips go 
into edit together. 

 



Multi-track Editing 

When you are ALT-selecting, if you want to work on a 'two-clip' edit, you should 
select across all clip ends to be included in the edit.  The DN9696 can edit 
multiple clips together, even if they do not have the same beginning or end 
times, or the same length fades.  By ALT-selecting the 'region' encompassing the 
edit, you choose which edit is being worked on. 

To change between adjusting one side of the two-clip edit, for example, if you 
want to adjust the outgoing fade-out without adjusting the incoming fade-in, just 
ALT-scratch across the left/right side of the edit.  You don’t have to come out of 
PLE first. 

You can change selection 'on the fly', thus putting different selections into PLE. 
 Note that you can also change the enabled tracks 'on the fly' to change which 
streams are/are not being edited.  You should disable streams that you do not 
want to edit, you can still use the ALT-selection method to select all clips 
vertically — those on disabled tracks will not be edited.  Alternatively, you can 
use normal box selection or SHIFT-selection methods to select the clips that you 
wish to edit. 

When you are working with multiple clips in a 'two clip' edit, selecting and 
dragging the edit point will move both the fade-out and the associated fade-in. 
 Similarly, ALT+drag changes the fade shape (SHIFT+ALT+drag being the 
'coarse' control as normal) for both points. 

Note: ALT-clicking inside the 'edit' or 'crossfade' area will perform a fade-
shape change, whereas ALT+clicking outside this area will perform the 
'vertical-select' function. 

If, by mistake, you select a region that includes more than two clips on any single 
stream, a message will appear informing you to reduce the number of clips per 
stream in the selection. 

Yellow group clips are treated as a single clip, but when they are in PLE you 
cannot adjust the internal edits, only the start and end of the yellow clip.  You 
can only move the start and end of a yellow group up to the next internal edit — 
any further would break the internal edit, which is not allowed.  (It is assumed 
that you grouped the clips together to 'lock' the internal edits.) 

Examples of two clips per stream selection 

Example 1 — ALT-selecting across all streams 



 

On each of the eleven streams (in the previous diagram) a crossfade is enclosed 
in the ALT-selected region, and thus on every stream.  When you drag the 
crossfade edit while in PLE, all of the edit points will move together as shown in 
the following example (the crossfade has been moved across all streams about 
two seconds to the right). 



 

 

Example 2 – Selective ALT-selecting 



 

In this example, you can see that edits to the two saxes (Sax1 and Sax2 in 
streams 8 and 10) are not enclosed by the ALT-select region, but it does touch 
the left side clips on those three streams.  Also, in the following diagram, when 
you drag on the edit point (in this case it has been moved two seconds to the 
left) the right side of the sax clips are not edited (and in this case a gap is 
created). 



 

 

Example 3 — Using Stream enabling/disabling in conjunction 
with ALT-select 



 

Here, streams 7, 8, 9 and 10 (dark grey) have been disabled for the Amb, Saxes 
and Hammond, and ALT-select used to enclose all the crossfades.  The crossfade 
was then dragged two seconds to the left — you can see below that the 
crossfades on the enabled streams have moved together, but those on the 
disabled streams have not moved at all. 



 

 

Examples of one clip per stream selection 

The following examples shows that where you box-select (or ALT-select) is 
important.  In all these cases two clips end up being selected in red.  However, 
the areas enclosed when the selection was created determines how the edit 
works. 

Example 4 — Selecting the start of both clips or the end of 
both clips using box-selection 



 

 

 

In any of these three examples (above) the in-points of both clips are edited 
together.  Similarly, the out-point of both clips move together.  In this case, ALT-
selection of the same regions would have the same effect. 



Example 5 — Selecting the start of the lower clip and the end 
of the top clip (that is, the edit point between a 'chequer-
boarded edit pair') 

 

In this example, the edit between the two clips is selected and so, when you 
adjust the end of the top clip, the start of the lower clip will move at the same 
time.  Editing the start of the top clip or the end of the lower clip will edit each of 
them alone. 

 



Region Editing 

Region Editing 

The basic principle of region editing is that you first define a 'region' of the 
playlist and then perform another action on that region.  The region is defined 
between the standard left and right markers, and across all enabled tracks. 

 

You can use the region editing tool for removing a section, or for moving it or 
copying it elsewhere.  Where you might otherwise use razor cutting and playlist 
editing, defining a region and deleting it can be very quick, particularly for 
repetitive tasks. 

Because region edit uses the left and right markers, this is also a useful tool for 
setting a loop. 

There are also keyboard hotkeys for the region editing functions, which can speed 
up operation significantly. 

 
To enable region editing, click the Region editing button.  Region editing 
is enabled when the button is pressed in.  The pointer will change to a 
pencil tool icon. 

 



Defining/Adjusting The Region 

Defining the region 

When region editing is enabled the pointer will change to a pencil tool icon , 
which signifies that you are ready to define a new region. 

To define the region, drag across the clips from left to right/right to left using the 
  pencil.  The region will be dark red, with the left and right locators positioned 

at the start and end of the region, respectively. 

Adjusting the region 

Clicking outside the defined region also changes the pointer to a pencil tool icon 
, and will start making a new region.  You can use this method to redraw the 

region from scratch. 

When the pointer is close to the start or end of the region, the pointer's icon will 
change to a left pointing  or right pointing  arrow shape.  You can adjust 
the region's start or end point by dragging one of these pointers. 



Region Editing Functions 

To discover what you can do with region editing, simply press the DELETE key on 
the keyboard. 

Assuming you have slip switched off, you will see the region disappear, and razor 
cuts are made to tidy up the ends of the clips left behind.  Press undo and then 
set slip to be right.  Press DELETE again; this time the region will disappear, but 
all clips to the right are slipped to fill in the hole. 

 
Press undo, but this time click the Cut entries to paste buffer button. 
 The same thing as before will happen: the region disappears and the clips 
move left to fill the hole. 

 
Go to the end of the playlist and click the Paste to cursor button; the 
pointer will change to the paste icon.  Clicking inside the playlist will drop a 
copy of the whole region into the playlist. 

 
Alternatively, you can use the Copy entries to paste buffer button 
instead of  Cut entries to paste buffer to leave the original region 
unchanged (and un-razored), and to allow you to paste a copy of the 
region elsewhere in the list. 

Note: You may want some tracks of the playlist to be unaffected by region 
editing.  Region editing only works on tracks that are currently enabled 
(see Enabling Tracks).  However, if you have a mix of enabled and 
disabled tracks, you may have to ungroup multi-channel clips first before 
some functions are allowed. 

There are several other extra functions that can be used during region 
editing, which are only available as hotkeys — go to Hotkey Setup and look in the 
'Region Editing' category. 

3&4 Point Edit N/A. 

Enable 3&4 point N/A. 

Enable Regions Switches on region editing (default SHIFT+R). 

Insert/Overwrite 
Mode 

Determines what happens when you paste a region into the 
playlist. 

Play Edit without 
Region 

This is a preview function that performs a dummy edit, as if 
the region had been deleted.  You would normally use this 
with slip enabled, otherwise it will preview a hole! 

Razor Edges Makes two razor cuts to split the clips at the left and right 
markers. 

Region Duck N/A. 

Snap L&R to cuts This is a useful feature for making sure that a region 
selection selects complete clips.  To use this, draw a region 
close to the end of the clips you wish to select, then press 
the key for this (default #).  The region will move to the 
nearest clip ends. 

Source/Dest 
focus toggle 

N/A. 



Zoom to Region 
End 

This key (default SHIFT+C) locates the current time to the R 
marker and changes zoom to a preset zoom, as set in the 
Playlist Display Setup page/'Horizontal region edge zoom 
level'. 

Zoom to Region 
Start 

This key (default SHIFT+X) locates the current time to the L 
marker and changes zoom to the same preset zoom. 

Zoom-In on 
Region 

This key (default SHIFT+Z) changes the zoom so that the 
entire region is viewed at an optimum zoom level. 

 



Menu Reference 

File Menu 

The File menu includes some of the usual file-related functions, such as the 
loading and saving of projects. 

 

Disk Manager Opens the file browser of the DN9696.  For the most 
part this duplicates file operations that are available in 
Windows Explorer (see Disk Manager). 

New Project Creates a new project and opens the New Project 
window.  If a project is already open, you will be asked 
to save it. 

Open Project Opens a browser from which you can choose an 
existing project to open. 

Close Project Closes the project. 

Save Saves the current project (default CTRL+S). 

Save As Saves the current project, but first opens a window that 
allows you to change the name of the file being saved. 
 This way you won't overwrite the original file because 
you are creating a new one. 

Delete Project Deletes the current project.  The project file (EDL) and 
the audio files will be deleted, but the mirror files will 
not.  If you want to keep the project EDL file on the 
mirror, make sure you save the project first before 
deleting it — Save (project) also triggers a save of the 



EDL file to the mirror drive if the Mirror Project Files 
option in the Record Setup is appropriately set. 

Load to paste Provides a method of copying and pasting clips from 
one playlist to another.  Load to paste will open a 
browser from which you can choose another 
playlist/EDL.  After you have chosen one, the entire 
playlist will be loaded into the paste buffer, so that 
when you press the paste button, you can drop that 
playlist into your current one. 

Last used... 
1... 
2... 

Shows a list of the most recent files that have been 
saved or opened.  To open a file, click on it. 

Install Plug-in Options N/A. 

Exit Closes the DN9696 software, prompting you to save 
the project if it has been modified since the last time it 
was saved. 

 



Edit Menu 

The Edit menu contains the standard Windows cut, copy, paste and associated 
commands. 

 

Undo record into 
playlist 
Redo 

Undo reverses the last action in the playlist.  A short 
description of the action involved is shown in the menu. 
 Redo reverses an undo.  Up to 50 levels of undo are 
available. 

Cut 
Copy 
Paste 

See cut, copy and paste. 

Select All 
Deselect All 

Selects/deselects all of the clips in the playlist. 

 



Playlist Menu 

The Playlist menu has numerous commands. 

 

Vertical Zoom 
Horizontal Zoom 

These provide an additional method of changing zoom 
and, in listing the individual zoom levels, allow you to 
jump from one zoom level directly to another without 
going through the intermediate levels. 

Profile Display Mode Allows you to change the scaling of the waveforms, for 
example, to make lower level audio appear visually 
larger.  There are eight presets, where 1 (default) is 
the best all-round mode, and  6, 7 and 8 will visually 
boost quieter audio. 

Make all clips active 
Make all streams 
active 
Make all enabled 
streams active 

These commands provide a way of making all clips or 
tracks (streams) active if any have been made inactive. 
 Inactive clips or tracks are 'virtual' clips (or tracks) and 
do not play; their waveforms appear grey.  See Track 
Groups. 

Record enable These two commands are the equivalent of pressing 



selected streams 
Disarm all record 
enabled streams 

and holding the RECORD button (front panel of 
DN9696) when the DN9696 is stopped. 

Adjust level of 
selected clips 

Acts on all red selected clips.  When selected, the 
Adjust level of selected clips window opens (see 
Adjusting Clip Levels), which allows you to change the 
clip level. 

Normalise level of 
selected clips 

Although this command is not really applicable to the 
DN9696, it is described in Adjusting Clip Levels. 

Expand selected clips If a multi-channel clip has been ungrouped, this 
command expands each channel of a clip back to its 
original channel width. 

Centre display on 
timeline 

Scrolls the playlist so that the current timeline is 
centred in the display.  This is only of use if Stationary 
Timeline is switched off. 

Auto return on play 
Auto return on stop 

These auto-return modes return the current time to the 
last position that playback was started from (see 
Transport Controls). 

Play select entries Plays only selected entries, muting all others, and stops 
playback when the end of the selected clips is reached. 
 Default hotkey is P (see Hotkey Setup). 

List missing tracks Creates a message box that lists missing files if the 
playlist has clips that are not linked to audio files. 

Monitor Source N/A. 

Save Stream Name 
Template 
Load Stream Name 
Template 

Having renamed the tracks (streams) of the playlist, 
the list of track names can be saved as a template, so 
that you can reload them later into a fresh playlist to 
save you typing them in again. 

 



View Menu 

The View menu has commands for opening ancillary windows, and managing 
hotkeys and settings. 

 

Setup Window Opens the Setup Window. 

Time Display Window Opens the resizable, floating Time Display window. 

Video Window N/A. 

Input Monitor Window Opens the Input Monitor window, which reports the 
status and messages appearing on the AES50 audio 
inputs. 

Sync Monitor Window Opens the Sync Monitor Window, which reports the 
status and displays speed fluctuations on any incoming 
LTC. 

Record Messages 
Window 

Opens the Record Status Messages Window, which 
keeps a log of any error messages relating to the disk 
drives. 

Load Hotkeys 
Save Hotkeys 

Loads/saves the entire hotkey configuration (see 
Hotkey Setup). 

List of hotkey files Lists the most recent hotkey (.hky) files that have been 



saved or opened.  Click on the file name to open it 
without having search for the file. 

Load Settings 
Save Settings 
Reset all settings 

Loads/saves/resets setting (see Saving and Loading 
Settings). 

List of settings files Lists the most recent settings (.sst) files that have been 
saved or opened.  Click on the file name to open it 
without having search for the file. 

 



Help Menu 

The Help menu contains commands for displaying hardware and software 
information, diagnostics and opening the Help file. 

 

About Klark Teknik 
DN9696 

Displays information about the DN9696 software 
version and build numbers. 

Help on Klark Teknik 
DN9696 

Opens the online Help file (this document). 

Hardware 
Configuration 

Displays information about the DN9696 hardware. 

Dsp Bandwidth Test Shows read and write speeds to and from all the 
processors in the system.  Used for diagnostic purposes 
only. 

Disk Write Bandwidth 
Test 

Measures transfer speeds to the disk drives being used 
by the system.  Used for diagnostic purposes only. 

 



Clip Menu 

There are further assorted functions available on a menu by right-mouse-clicking 
over a clip in the playlist. 

 

Cut selected entries 
Copy selected entries 
Paste 

These are the standard cut, copy and paste commands. 

Re-create profile Although similar to the Re-create profile command of 
the Source Tracks Folder, this acts on the source file 
associated with the selected clip.  This is useful because 
it is not always easy to find the right source file for a 
clip in the Source Tracks Folder. 

Edit entry name Opens up a little window that allows you to type a new 
name for the clip.  This is a clip name and doesn't 
rename the source audio Files.  The hotkey for this 
command is Edit name of selected entry and is 
default Y (see Hotkey Setup). 

Reverse Entry N/A. 

Delete Entry Deletes the clip. 

Snap entry in point to 
current time 
Snap entry's end to 
current time. 

Reposition the clip so that its start (in-point) or end is 
placed at the current timeline. 

Make clip inactive Inactive clips are 'virtual' clips, and will not play or 
consume any resources.  Their waveforms are 
displayed in grey to signify that they are inactive. 
 There is some discussion of inactive tracks in Track 
Groups; inactive clips are the same thing, but individual 
clips can be 'turned off' as opposed to making a whole 
track inactive. 

 



Setup 

The Setup Window 

You can customise your DN9696 working environment.  The DN9696 has a 
settings window that contains a Topics menu on the left for topic selection and a 
panel on the right for the selected topic, which contains its configurable 
parameters.  The settings window overlays the main display. 

Topics with a plus-sign  on the left have a sub-topics menu (see below).  The 
minus sign shows that the topic's sub-menu is open. 

    

The default settings and appearance of the DN9696 software have been designed 
for ease of use and are aimed at streamlining the major tasks a DN9696 is 
expected to perform, so you may never have to go to the set up pages. 
 However, you may find a useful feature or a way to change the logic of a 
function that could be used to speed up certain operations. 

The Setup Topics section describes the function of every set up option. 

 To open the set up window 

Choosing View > Setup Window. 

 To select a topic 

Click on it in the Topics list. 

 To open/close the sub-menu of a topic 

Double-click the topic name. 

 



The Setup Topics 

The following lists the topics and sub-topics available in the Topics menu. 

General Setup 
General 
Status Displays 
Autosave 
Drag And Drop 

Audio Setup 
Audio 
Further Audio Settings 

Sync Setup 
Sync  
Autostart & Offset 

Pre/Post Roll Setup 
Pre/Post Roll 

Playlist Setup 
Playlist 
Playlist display 
Playlist Entry Display 
Playlist Nudge 
Playlist Autostop 
Playlist Streams 

Clipstore Setup 
Clipstore 

Undo Setup 
Undo 

Default Crossfade Setup 
Default Cross Fade 

Transport Controls Setup 
Transport Control 
Scrub Setup 

Project Management Setup 
Project Management 

Hotkey Setup 
Hotkey setup 

EDL Conversion Setup 

Locators Setup 
Locators 

Record Setup 
Record 

Record Safe Setup 
Record Safe 



Saving And Loading Settings 
 



General Setup 

General 

Time Format Selects the format for all time displays: 

 Timecode Hours : minutes : seconds : frames (as per the 
global frame rate) : bits (80 per frame) 

 Milliseconds Hours : minutes : seconds : milliseconds 

 Samples Hours : minutes : seconds : samples (96000 
per second) 

 CD Hours : minutes : seconds : CD Frames (75 per 
second) 

 Bars and 
beats 

Bars : beats : ppqn (parts per quarter note) 

Time Format 
Settings 

Allows you to set the tempo, time signature and ppqn for the 
bars and beats display.  This sets the default tempo etc. for a 
new project.  Make a new project to apply new settings for 
this.  It is possible to change the tempo displayed using a 
status display (see below). 

Time Based 
Settings 

N/A.  (The DN9696 always runs at 96kHz sample rate.) 

Warning 
Message Level 

Allows a choice of four different settings.  Leave this set to 
'Display all messages' until you are familiar with using the 
DN9696. 

Message Box 
Placement 

Allows you to change the position on the desktop where 
messages, warnings and errors appear.  Click Test to check 
its position. 

Popup Help When ticked, tooltips (with yellow background) appear when 
the pointer is over a button for a couple of seconds.  The 
tooltip shows you the button's name. 

File Info Popups Enables/disables clip 
tooltips in the Source 
Tracks Folder (a typical 
example is shown left). 
 Use the Clipstore Setup 
page to set which file 
parameters are displayed 
in these tooltips. 

Record Auto 
Cleanup 

Caution: Use this command with care!  This is the only 
destructive editing process on the DN9696. 
 
When this command is ticked, if clips are deleted from 
the playlist so that some source files are no longer 
used, the unused source files will be deleted.  They will 
be deleted from both the primary and the mirror drives. 



Classic View When this command is ticked, texturing will be removed from 
some of the DN9696's interface and the buttons will have 
permanent outlines. 

Status Displays 

The status displays (bottom of screen) can be set to display the current status of 
a number of settings.  Also, by right-clicking or double-clicking on these status 
displays, some functions can be changed or enabled/disabled without having to 
open the setup window. 

It is possible to display the following settings in up to eight displays.  The Display 
Titles tick box allows you to save space on the status bar by abbreviating the 
name of the setting that is being displayed. 

None The status display does not show anything for this display 
position. 

Sample Rate N/A.  (The sample rate is fixed at 96kHz.) 

Frame Rate Right-clicking allows you to select a different frame rate. 
 Double-clicking on the display will open the Sync Setup 
page. 

Transport 
Controls 

N/A. 

Autoplace Right-click on the display to change Autoplace settings. 
 Double-click to turn Autoplace on/off. 

Slip Right-click to change Slip settings.  Double-click to turn Slip 
on/off. 

Input Source Double-clicking on the display opens the Audio Setup page. 
 However, in practice the DN9696 will always be set to record 
from the AES50 inputs, and will not change. 

Clock Source Double-clicking on the display will take you to the Audio 
Setup/Further Audio Settings page.  In practice, the DN9696 
will usually be set to genlock to the AES50 inputs, so you 
won't need to change this. 

Input Res Double-clicking on the display will take you to the Audio 
Setup page.  Right-clicking on this Status Display allows you 
to select a different input bit rate.  However, there is no real 
advantage in this, so the DN9696 should be left at 24bps. 

Output Res See Input Res. 

Tempo Double-clicking on the display will allow you to alter the 
tempo of the current playlist. 

Varispeed N/A.  (It is not possible to Varispeed on the DN9696.) 

Output Format N/A. 

Record Format Allows you to change the file format that the DN9696 records 
to.  By default this will be set to Native and the format used 
will be Broadcast WAV (BWF).  We recommend that you do 
not change this. 

Auto return Right-click to cycle between Off, Auto Return on Play and 
Auto Return on Stop (see Transport Controls).  If you enable 
this in either of the auto return modes, double clicking turns 



it on/off. 

Scroll playlist Right-click or double-click to turn the playlist scrolling on/off. 
 Disabling the scrolling allows you to visually focus on a 
particular area of the playlist without it scrolling off the 
screen as it plays. 

Stationary 
Timeline 

Right-click to turn stationary timeline on/off.  The timeline is 
usually fixed, and the clips move from right to left past it. 
 When this command is off, the timeline moves, and the clips 
only move when the timeline reaches the edge of the screen, 
where the 'page turns'. 

Time Format Right-clicking allows you to change the time format to 
milliseconds, frames etc. 

Autosave 

The DN9696 automatically saves the playlist EDL file to temporary files.  The EDL 
file is less crucial than the audio files.  However, if for any reason you need to 
revert to an older version of the EDL, there are two backup schemes. 

Create backup 
files when saving 

When an EDL is saved, the version before the save, is 
renamed to "*.bke".  For example, if you save "FRED.EDL", 
the old version becomes "FRED.BKE".  These are in the same 
directory on the C: drive as the EDL file. This setting allows 
you to disable this function. 

Auto save files DN9696 also automatically saves the EDL every few minutes. 
 This setting allows you to change the time between these 
automatic saves (the default is five minutes).  These are 
saved to the Windows User's temporary directory (usually 
C:\Documents and Settings\DN9696\Local Settings\Temp - 
this may be a hidden directory) and are named: 
"Sd3savxx.~dl", where xx counts up to 99 and then wraps 
around to 01 again. 

Time between 
autosave  
( minutes ) 

Sets the time between automatic saves of the EDL file. 

Drag And Drop 

You can drag audio files from Windows Explorer directly into the playlist.  By 
default, the EDL links to the audio files in their original location, but when the 
Copy audio files dragged into the Clipstore / Playlist from Explorer 
command is ticked, a drag and drop will cause the files to be copied to the 
project's home directory.  However, this could cause a delay while you wait for 
the files to copy. 

 



 



 



 



 



Audio Setup 

Audio 

None of the commands in this topic are applicable to the DN9696. 

Input Source Fixed to the AES50 inputs. 

Sample Rate Fixed at 96kHz.  Varispeed is N/A. 

Input Resolution 
Output 
Resolution 

Should remain at 24-bit.  You can change these, but it 
serves no purpose other than to reduce the quality of the 
inputs and outputs. 

Dual Wire Mode N/A. 

Channel Status Allows you to turn off input error messages.  Used for test 
purposes only. 

Further Audio Settings 

Clock Source  Allows you to switch the audio clock source between: 
Internal — if the DN9696 is standalone (that is, not 
connected to a console) and you wish to replay audio, switch 
the clock to internal. 
Genlock — the standard method of working when connected 
via AES50 to a console or other device. 
 
Video and Automatic (AES) are N/A. 

Emphasis N/A. 

Output Format Should be set to AES/EBU, as SPDIF is N/A. 

 



 



 



LTC Setup 

These topics allow you set up the way the DN9696 synchronises with 
internal/external devices and, if working with timecode, to specify the frame rate 
for any incoming LTC. 

LTC 

Frame Rate If the DN9696 is reading LTC from another device, you will 
need to set the frame rate to be the same as the LTC 
master.  If you are not using LTC, then this is not very 
important. 

Timecode Type Can only be LTC. 

Sync Mode DN9696 can only support Slave Mode. 

LTC Trigger Mode N/A. 

Slave Mode N/A. 

Timecode Slave N/A. 

Autostart & Offset 

Autostart Time When the DN9696 is in timecode slave mode, this sets the 
delay between detecting incoming timecode and starting 
playback.  This is normally automatic, and thus a low value 
of this is ignored.  However, you can set this higher and 
increase the delay to, for example, accommodate a disk 
drive that was slow to get into play or record. 

Timecode Offset When the DN9696 is in timecode slave mode, this sets a 
fixed difference between the DN9696's timeline and the 
incoming LTC. 

Flywheel Length 
Frames 

Sets the time for which the DN9696 will run on when 
timecode disappears.  This is usually only useful if timecode 
is from tape where there may be drop outs.  This is not really 
applicable to the DN9696, as it is set to continue recording if 
LTC disappears. 

Record stop time N/A.  (The DN9696 is set to continue recording if LTC 
disappears.) 

Record 
Timestamp Delay 

Sets the time between detecting a new timecode value and 
timestamping any recording that is made.  The default is one 
second, which is sufficient.  Increasing this would better 
accommodate a situation where, for example, LTC from a 
tape was intermittent or difficult to read at the very start of a 
take.  This could mean that if the recording was timestamped 
too early it could be stamped incorrectly.   However, this 
would be unlikely in the situations a DN9696 is expected to 
be working in. 

 



 



 



 
Pre/Post Roll Setup 

Pre/Post Roll 

There are three sets of four Preview functions that can be used for playing: 

 The whole edit. 

 Up to an edit point. 

 From an edit point. 

 Through (up to and from) an edit point. 

These have to be set as hotkey functions in the Transport -  Edit Controls 
category of Hotkey Setup, and are named: 

Preview edit 
Preview from edit point 
Preview thru' edit point 
Preview to edit point 
 
Shift Preview edit 
Shift Preview from edit point 
Shift Preview thru' edit point 
Shift Preview to edit point 
 
Ctrl Preview edit 
Ctrl Preview from edit point 
Ctrl Preview thru' edit point 
Ctrl Preview to edit point 
 
The SHIFT and CTRL set of functions perform the same action, but use different 
sets of pre-roll and post-roll times which are set in this topic  Times for before 
and after a given cut to play during playback in the trim window are: 

Pre Roll Length 
Post Roll Length 
 
Shift Pre Roll Length 
Shift Post Roll Length 
 
Ctrl Pre Roll Length 
Ctrl Post Roll Length 
  
By default, a normal preview will have a pre- and post-roll of about two seconds. 
 The shift previews are shorter at one second, while the Ctrl set are longer at four 
seconds. 

 



 



 
Playlist Setup 

Playlist 

This topic contains setting describing the behaviour of the playlist. 

Number of 
playlist streams 

N/A.  (The number of playlist streams is set in the New 
Project window.) 

Cut mode This determines what happens when a razor cut is made to 
split clips.  By default (splice mode), every razor cut causes 
a very short crossfade to be made, whereas 'V Cut' mode 
would make the razor as a quick fade down, then up again, 
that is, there would be a very short dip in level.  An 
advantage to a V cut is that this would never cause overlaps 
where two clips are playing together.  However, the DN9696 
has plenty of resource to cope with short crossfades on every 
track, and thus the Splice mode works better. 

Restrict to one 
open playlist 

N/A. 

Stop 
automatically 
when cutting 
with the razor 

The DN9696 will stop playback when the razor tool is used. 
 This is off by default. 

Autolocate on cut Only applicable to the DN9696 if you are doing a lot of 
editing using slip.  The "cut" referred to here is cut and 
paste.  If this setting is enabled, when slip is on and when a 
clip is deleted or cut-to-paste, the timeline moves by the 
length of the deleted clips.  This is useful when you are 
editing with slip, and keeps the view focussed at the right 
position after an edit. 

Cancel region edit 
with right mouse 
click 

Right-clicking in region edit mode exits that mode. 

Double click 
opens clip details 

N/A. 

Double click 
starts play 

When this is ticked (default), double-clicking anywhere 
within the playlist starts playback.  When unticked, the 
double-click area is restricted to just the white time bar. 

Auto load new 
edit into current 
playlist if empty 

N/A. 

List missing 
tracks on opening 
playlist 

If audio files that are used in the playlist are not found, you 
are informed when the playlist is loaded.  This command 
allows the messaging to be turned on/off. 

Autoplace options The time set in Separation defines the gap used when using 
Autoplace/Gap mode. 
Use Fades — when ticked, a Butt autoplace will place the 
start of a clip against the start-of-fade (that is, not exactly at 



the end of the previous clip, but a fade-length earlier), so 
that the two clips crossfade.  When Use Fades is not ticked, 
they will be placed end-to-end with no crossfade. 
View quantise as fractions instead of musical notation 
— N/A. 

Playlist and Trim 
Edit 

N/A. 

Playlist display 

This sub-topic contains settings relating to how the playlist is displayed. 

Stationary 
timeline 

Stationary timeline during playback — when ticked, the 
current timeline is stationary and, as the DN9696 plays, the 
clips move right to left through the timeline.  When unticked, 
the current timeline moves left to right across stationary 
clips. 
 
% of playlist width — changes the position of the current 
timeline.  It is placed at 75% by default, which is best for 
recording.  However, when playing it may be better to move 
it so that you can see more of the approaching audio. 

Always display 
mouse time in 
playlist 

Changes the behaviour of the small red time display at the 
lower-left of the playlist.  When unticked (default) this 
displays the time at which the pointer is resting, but when 
you pick up a clip to move it the display will show the time of 
the start of the clip.  When ticked, the display always shows 
the mouse time. 

Horizontal region 
edge zoom level 

Sets the zoom level used by the Zoom to Region Start and 
Zoom to Region End commands in Region Edit. 

Playlist Entry Display 

Fade display 
mode 

Changes the way crossfades are displayed.  This is not 
important unless you are editing and your fades are 
significantly long. 

Fade curve 
display mode 

Changes the way fades are displayed. 

Keep updating 
waveforms when 
playing (slow) 

Turns off the display of waveforms at higher zoom levels 
during playback. 

Show higher 
zoom waveforms 
as lines 

Changes the way the waveforms display for higher horizontal 
zooms.  By default, the graph is filled in between the 
waveform and the 0dB centre line.  However, by ticking this 
command the waveform will be shown as just a line graph. 

Draw profiles 
proportional to 
clip level 

When ticked, the profile displays grow/shrink as clip levels 
change. 

Draw original clip 
profile in red 
when selected 

When the Draw profiles proportional to clip level 
command is ticked, the original profile is drawn as a dark 
grey background (otherwise lower level clips could 



disappear).  This option allows this background to be 
coloured red (or not) when the clip is selected. 

Draw black 
outlines on 
profiles up to 
zoom level 

Draws a black outline at the top and bottom edge of the 
profile, which is purely a cosmetic feature.  You can choose 
the zoom level at which this stops being displayed. 

Maximum non-
waveform zoom 
level 

Sets the threshold at which waveforms stop being drawn 
from profile files, and start being generated 'on the fly'.  You 
must restart the DN9696 after changing this 
command. 

Auto-select 
'recording clip' on 
entering record 

Ensures that the clip for the current recording is selected. 
 This can be useful if any editing is taking place during 
record. 

On copy/move 
entry(s) show 
guidelines for 

N/A. 

Profiles 

The DN9696 uses two methods for displaying the audio waveforms.  At wider 
horizontal zooms (viewing more time) a profile file is used.  This profile file is 
created during recording, and this is essentially a very low resolution audio file 
(approximately 100 samples per second).  Displaying from the profile is quick, 
and the screen updates are instant.  When viewing in finer detail (viewing less 
time) the profile file resolution is too a low, so the waveforms are drawn by 
analysing the section of audio that is being shown on screen.  This method can be 
a little slower, particularly with large number of tracks on screen. 

There is a setting that allows you to change this profile/waveform threshold. 

CTRL+clicking on the horizontal zoom buttons opens a menu that allows you to 
jump directly from one zoom level to another.  Each zoom level is numbered and 
there is a divider bar between zoom 13 and 14 (to show that the waveform 
switches from profile files at zoom 13 to 'on the fly' at zoom 14).  The other 
divider (between 21 and 22) signifies another subtle change to the waveform 
display.  The change is graphical in that, at this zoom level, each sample is 
displayed, whereas at lower numbered zooms each pixel displays the peak level 
of several samples. 

Playlist Nudge 

You can configure the nudge amounts applied when using the entry nudge button 
or hotkeys.  There are three sets of hotkeys that can move an entire clip, or 
selection of clips by a small amount.  The hotkeys set up in the Playlist — 
Autoplace category in Hotkey Setup. 

Both the Nudge Amount and Alt+Nudge Amount sections let you set the 
nudge amount using the following: 

 Zoom dependent — lets you set the number of pixels per nudge by using 
the up/down spin buttons in the Nudges per pixel box. 

 Nudge by fixed time — lets you set the time per nudge via the spin 
buttons in the box to the right. 



Nudge Left and Nudge Right nudge by the amount set for the standard Nudge 
Amount.  Default keys are SHIFT+CTRL+LEFT ARROW and SHIFT+CTRL+RIGHT 
ARROW, respectively. 

Alt + Nudge Left and Alt + Nudge Right nudge by the amount set for the Alt 
+ Nudge Amount.  The default keys for these are SHIFT+CTRL+ALT+LEFT 
ARROW (ALT+9) and SHIFT+CTRL+ALT+RIGHT ARROW (ALT+0), respectively. 

Variable Nudge Left and Variable Nudge Right open a window that lets you 
set the amount of nudge.  For example, if you want to move a clip exactly 1 
minute and 25 seconds, you can type in this offset.  This offset time will persist, 
so if you are repeatedly moving clips by the same amount, all you have to do 
thereafter is press the ENTER key to confirm the nudge.  The default keys for 
these are CTRL+9 and CTRL+0, respectively. 

Nudge and Alt + Nudge can be set to explicit values or set to vary according to 
the zoom level. 

The Nudge Up and Nudge Down hotkeys move clips up or down one stream. 

Playlist Autostop 

The DN9696 can be set to automatically stop playback on reaching the end of the 
last clip in the playlist. 

Autostop at end 
of edl 

Never — playback carries on after reaching the end of the 
last clip in the playlist. 
Always — playback always stops automatically when the 
end of the last clip in the playlist is reached. 
Only in transmission mode — playback will only stop 
automatically when the end of the last clip in the playlist is 
reached if the DN9696 is in transmission mode. 

Playlist Streams 

User configurable 
horizontal PPMs 

These are controls change the size and thresholds of the 
metering (see Meters). 

Peak displays See Meters. 

Primary solos 
mode 

This section changes the logic of the solos . 
 
Additive (default) — pressing one solo button mutes all 
other tracks, but subsequent solos unmute those tracks, 

thus, multiple tracks will be heard.  Use the large  button 
to unsolo all tracks. 
 
Exclusive — each press of a solo button mutes all other 
tracks, always leaving only one track being monitored.  This 
only applies to the software controls, as the front panel's 
solo is always exclusive. 
 

Note: You can momentarily change the logic by 
pressing SHIFT when pressing a solo button.  So, in 

the default additive mode, SHIFT+  will solo the 



selected track and mute all others. 

E to E mode Determines how monitoring of the inputs works.  By default, 
when a track is record enabled, the signal on the input is 
monitored.  This allows you to turn that off — although, in 
the context of the DN9696, you shouldn't need to do it. 

 



 



 



 



 



 



 



Clipstore Setup 

Clipstore 

The Clipstore topic lets you set up the Source Files Folder. 

Initial display 
settings 

N/A. 

Metadata sorting If you are actively using scene numbers to identify takes, 
you can change the way the Source Tracks Folder lists the 
recordings.  Ticking the Sort by scene and take box will 
group recordings of the same scene number together. 

Popup bubble 
 filters 

The tick boxes allow you to choose which file parameters are 
displayed when the pointer pauses over a file in the Source 
Tracks Folder.  iXML metadata will only be shown if it is set 
to be recorded (see Record Setup). 

 



 



Undo Setup 

Undo 

This topic lets you disable undo or change the number of undo levels from its 
maximum of 50.  However, it is unlikely that you will ever want to change this 
setting. 



 



Default Crossfade Setup 

Default Cross Fade 

Every clip in the DN9696 has a fade at the start and end.  Usually very short, its 
main purpose is to smooth the beginning and end of the audio clips and to avoid 
the common digital audio phenomenon of 'zero crossing glitches'. 

By using the playlist editing functions (Fades and Crossfades), these fades can be 
extended and reshaped to perform longer fades or crossfades between clips. 
 There are a total of 117 fade shapes to choose from. 

 



 



Transport Controls Setup 

Transport Controls 

loop pre-roll 
loop post-roll 

Allows you to set a pre-/post-roll time for the loop function. 

Fast Forward & 
Rewind Speed 

This command sets the speed that is used to move the 
current timeline when pressing either the rewind/fast 

forward buttons . 

Scrub Setup 

The Fixed Speed Scrub section has three scrub speeds that you can adjust 
using the up/down spin buttons.  Their assigned forwards and backwards hotkeys 
are also shown. 

 



 



 



Project Management Setup 

Project Management 

The setting for Default root directory in  which to create new projects 
allows you to change where the project files (that is, the EDL files and the audio 
files) are saved. 

Default file locations 

The files created by DN9696 are stored in a subdirectory that has the same name 
as the project.  For example, a project called "prjname" will have the following 
locations: 

File Type File Extension Default Location 

Project/Playlist .edl C:\projects\prjname\prjname.edl 
 
An extra copy is also saved in the audio 
directory of the mirror drive(s). 

Primary Audio 
Files 

.wav E:\prjname\xxxxxxx.wav and 
F:\prjname\yyyyyyyy.wav 

Mirror Audio Files .wav K:\prjname\xxxxxxx.wav and 
L:\prjname\yyyyyyyy.wav 
 
The drive letters are dependent on the 
type of removable drive being used, that 
is, eSATA or FireWire. 

 

Other files used by the DN9696 are: 

File Type File Extension Location 

Settings .sst C:\Documents and 
Settings\DN9696\Application Data\ 
Studio Audio & Video\SADiE 
MTR\settings 

Hotkeys .hky C:\Documents and 
Settings\DN9696\Application Data\ 
Studio Audio & Video\SADiE 
MTR\hotkeys 

Stream Name 
Template 

.xml C:\projects 

Metadata 
Template 

.xml C:\Documents and 
Settings\DN9696\Application Data\ 
Studio Audio & Video\SADiE 
MTR\metadata 

Temporary EDL 
files 

.nne C:\Documents and 
Settings\DN9696\Application Data\ 
Local Settings\Temp 



5 minute Auto-
Save EDL 

.~dl C:\Documents and 
Settings\DN9696\Application Data\ 
Local Settings\Temp 

Backup EDL file .bke C:\projects\prjname 

Profile Files .pfm, .pfr and .pfl The files that store the waveform 
display are always in the same directory 
as the audio files they represent. 

 



 



Hotkey Setup 

Hotkey setup 

You can assign computer keyboard keys to on-screen buttons or menu 
commands, which can speed up operations for repetitive tasks and provide an 
alternate to using the mouse. 

Categories This panel lists all the possible program areas that are likely 
to contain the command to which you want to assign the 
hotkey.  Click on the one you want to select it. 

Commands Lists all the commands associated with the selected 
category.  Click on the one you want to select it. 

New hotkey This panel has a drop-down list containing a list of keyboard 
keys from which to choose your hotkey.  Tick any 
combination of the Shift, Ctrl and Alt hotkey modifiers 
(below this panel) if necessary. 
 
AutoRepeat — when setting hotkeys, you can set them to 
automatically repeat when the key is held down; tick 
AutoRepeat before pressing assign.  If you want to add the 
AutoRepeat command to an existing hotkey setting, you 
must first use Remove to remove the old key from the list 
and reapply it with AutoRepeat selected.  If the repeat 
speed is not suitable, there is a Windows setting for this in 
start > Control Panel > Keyboard. 

Hotkeys assigned This panel lists the hotkeys that are currently assigned to the 
selected command.  You can assign multiple hotkeys to a 
single command. 

Currently in use 
for 

When a keyboard key and modifier key combination are 
selected that is currently assigned to another function, that 
function will be displayed here. 

Assign Press Assign to add the selected new hotkey (see New 
hotkey) to the list of those assigned to the command. 

Remove In the Hotkeys assigned panel, click the key combination 
you want to remove and then click Remove.  It will be 
removed from the list. 

Reset All Resets all hotkeys in the DN9696 to their factory defaults. 

Dump Keys Allows you to save the current hotkey settings to a HTML file, 
so that you can print out key assignments by function, which 
are grouped into their program areas. 

Dump All Similar to Dump Keys, this produces a HTML file listing all 
the assigned hotkeys.  This print-out lists the key 
assignments ordered by key as a table. 

Start/stop 
playback using 
spacebar 

When this command is ticked, you can use the SPACEBAR to 
start and stop playback. 

 



All alphanumeric keys can be used, along with the keyboard function keys F1 to 
F12.  Certain non-alphanumeric keys can also be used: 

¬ - = [ ] ; ' # \.. /  

TAB, ESC and SCROLL LOCK 

/ * - + (which are on the number pad when NUM LOCK is on) 

DELETE and ENTER on the numeric pad are the same as the standard DELETE and 
ENTER, so they are already included, but cannot be set separately. 

Some key combinations are fixed to standard Windows functions, that is, CTRL+C 
(copy), CTRL+V (paste), CTRL+X (cut), CTRL+Z (undo), CTRL+Y (redo), CTRL+A 
(select all) and ESC (deselect all). 

 

Pausing the pointer over a button will open its tooltip, which 
shows the button's name followed by any hotkeys assigned 
to it, enclosed by parentheses ().  For example, the Scissors 
mode button (shown left) has "X" assigned as its hotkey. 

You may Save and Load Hotkeys from the Environment menu, select Hotkeys 
then save or load and choose a HKY file. 

Hotkeys are also saved as part of a settings file. 

 



 



EDL Conversion Setup 

The software core on which the DN9696 is built includes support for importing 
from a number of EDL formats, most of which are legacy. 



Locators Setup 

Locators 

In this manual, the terms Marker and Locator are interchangeable. 

Slip default Slip-enable new numbered locators  sets the default 
state of the slip parameter in the Locator Table.  When 
enabled, markers will follow slip rules when slip is enabled, 
so if you are doing any editing that involves slip, the marker 
will slip alongside the clips and therefore will stick to the 
audio it is intended to mark.  Default is off. 
 
Slip-enable new named locators  N/A. 

Allow new 
locators to be 
moved using the 
mouse 

Sets the default state of the 'moveable' parameter in the 
Locator Table.  Default is on, so markers can normally be 
moved using drag. 

Multidimensional 
locators 

When ticked, any marker that is captured will save the 
screen view at the same time as storing the timeline 
position.  In the Locator Table these are displayed in the 
stream, vertical zoom and horizontal zoom columns.  Default 
is off. 

Allow quick set 
loop points 

If you click on a single marker in the Locator Table, the left 
marker is automatically set to that marker position, and the 
right marker is set to the position of the next marker in the 
playlist.  This function is called "quick set loop", and can be 
disabled with this setup option.  Default is on. 

 



 



 
Record Setup 

Record 

This topic contains the recording settings. 

Construct track 
names from 
record metadata 

This should be enabled, so that the names of the audio files 
include the project, scene and take fields entered in the 
Record metadata window.  If this is disabled, a simpler file 
naming scheme will be used, metadata will not be included 
and the filenames are entered in a small window that opens 
on the status bar.  It is not recommended to disable this 
setting. 

Record iXML 
Chunk 

When this is ticked, the metadata included in the audio files 
will be included in an iXML chunk as well as the BWF chunk. 
 If the metadata you are adding is important and some of 
the strings of data you are typing are long, we recommended 
that you enable this command.  Default is off. 

Pro Tools friendly 
filenames 

When ticked, the recorded audio files are named according to 
a convention, which ensures that when they are imported 
into a Pro Tools HAD system (v7.2 and higher) all tracks of a 
multi-channel recording will be automatically grouped 
together.  For more information, see Work Flow.  Default is 
on. 

Low disk space 
warning 
threshold 

Whenever the disk space on any drive goes below the 
threshold a warning will appear in the time field beside this 
setting.  The default setting is on and the warning will appear 
when 15 minutes of disk space (for the full number of tracks 
being recorded) remains on any disk drive. 

Metadata 
template file 

There are buttons to load and save metadata templates. 
 These contain the definitions for the metadata fields, their 
appearance in filenames and how they behave.  There are 
two default templates supplied: 
 

 record_metadata_template.xml and 

 us_record_metadata_template.xml 

The only difference is that the scene field is numeric in the 
standard template, whereas the US template allows alpha-
numeric scenes as per the US film convention. 

Optimised Record 
Mode 

This command is enabled by default and must be enabled in 
the DN9696. 

Optimised File 
Creation Mode 

This command is disabled by default and it is not 
recommended to enable this in the DN9696. 

Mirror profile 
files 

Determines whether or not profile files are recorded to the 
mirror drives.  The profile files are used for displaying the 
graphical waveforms, but it would only be useful to include 
them if the mirror drives were being post-produced on a 
SADiE system, or if the audio on the mirror drives is 



intended to be replayed on another DN9696.  Default is off. 

Mirror project 
files 

Determines whether or not the project file (EDL) is copied to 
the mirror audio drives.  Default is on. 

Polyphonic Group 
Size 

The DN9696 records to mono or stereo files.  It is possible to 
set it to record to WAV files containing more than two 
channels of audio, which are commonly known as 
"polyphonic WAVs".  These controls can set the number of 
channels in each polyphonic file.  The maximum is 16, so in 
this case a 96-channel recording would produce 6 x 16-
channel files.  However, this is not recommended as 
performance may not be as good as with mono files. 

Auto online when 
pressing record 

When the DN9696 is set to follow LTC, you need to switch on 
the Online button to enable sync.  This command, when 
switched on, ensures that you are always online during a 
recording, by automatically enabling it when record is 
pressed.  Default is on. 

Auto record on 
receiving 
timecode 

Although similar to Auto online when pressing record, 
this automatically goes into record when the DN9696 is 
online and linear timecode (LTC) is received.  Default is off. 

Enable record 
arming during 
playback 

N/A. 

 



 



Record Safe Setup 

Record Safe 

This topic has settings to help prevent accidental record problems. 

Lock out user 
input during 
record 

When the DN9696 is put into record, the Keyboard and 
Mouse Lock window opens displaying the "RECORDING" 
message (see the "Record lock" section in Transport 
Controls).  This locks out any mouse or front panel control, 
except for the STOP button.  To regain control, press STOP 
and hold it down for at least one second, which stops the 
recording.  You are then able to click the Regain control of 
DN9696 button to unlock the interface. 

Mute all playback 
during record 

Ensures that only the recording is monitored during record, 
and not any existing audio clips in the playlist. 

Always record 
enable all 
streams 

When ticked, the Record Arm All function arms every track. 
 When unticked, it record arms only those tracks that are 
edit-enabled. 

Prevent stream 
input bus routing 
from being 
changed 

Every track of the playlist can be set to record any of the 
AES50 inputs (with some limitations).  Pressing the 

show/hide inputs button  (upper-left corner of playlist) 
will reveal an extra button on each track.  Pressing this 
button opens a drop-down list (shown below) from which a 
different input can be selected.  A default playlist will always 
have Track 1 set to record from Input 1; Track 16 from Input 
16 and so on, although you can use these buttons to remap 
the inputs. 
 

 
 
By default, this option is ticked, so you will be prevented 
from remapping the inputs until it is unticked. 

All of these setup options default to on. 

 



 



Saving And Loading Settings 

The View menu includes the following settings commands: 

Load Settings 
Save Settings 
Reset all settings 

Settings are stored in the Windows User section of the system registry, and are 
updated as you change the settings.  The next time you use the DN9696, these 
changed settings will  be present. 

By using the Save Settings and Load Settings commands you can save your 
own settings file so that, for example, you could load onto a different DN9696 
unit. 

The Reset all settings command will check first to see if you want to save the 
current settings. 

 



Other Windows 

Disk Manager 

The Disk Management window (shown below) is a file manager that allows you 
to browse for files, and includes other file or disk level options. 

Note: As the drives of the DN9696 run under the Windows operating 
system, you may find that it is easier to use Windows Explorer for file 
operations. 

 

Operation is similar to most other file browsers.  The left column shows the 
drives, and if you double-click on a drive the display expands to show the top 
level folders.  The next column shows the contents of the selected drive/folder. 
 The column on the right displays file information, such as its type and when it 
was modified or created. 

Disk Management toolbar 

 
By default, this Only Show Tracks button is switched on, so the file 
display is filtered to display audio files only. 



 
When this Show All Files button is switched on, all files are listed. 

 
This Create directory button lets you create a new subdirectory.  (Right-
clicking on a folder also offers this option.) 

 
This Delete button lets you delete the selected file or folder.  Clicking this 
button opens a File deletion confirmation window from which to choose 
whether or not to delete your selection.  (Right-clicking a selected folder 
also offers this option.) 

 
Properties button.  Switch this button on so that a window opens 
displaying file details, such as sample rate, track number, metadata etc., 
when a file is selected.  If a disk drive is selected when it is switched on, 
information about the drive, such as capacity, space remaining etc., will be 
displayed.  If system (upper-left corner of Disk Management window) is 
selected, the Storage Properties window opens, which shows the 
available free space and the used space for all drives.  (Right-clicking also 
offers this option.) 

 
This preview file button previews selected file.  (Right-clicking a file also 
offers this option.) 

 
This rename button lets you to rename the selected file/folder.  (Right-
clicking a file/folder also offers this option.) 
 

Note: If you rename an audio file that is used by a saved project, it 
may not be able to find it when it is next opened.  Only the 
currently open project is updated with the new name.  It is usually 
better to rename files when the project is open and to do it from 
the Source Files Folder when the project is open. 

 
This Remove Drive button lets you remove a removable drive. 
 

Important: 
You should remove a drive correctly.  Do not unplug the 
cable or power it down without first having removed it via 
the software, either by using this option or by closing the 
DN9696 software and using Windows tools for removing 
drives (usually found to the right of the taskbar). 

 
Refreshes the DN9696's view of the disk drives (although this should be 
automatic and the DN9696 will recognise new drives soon after they are 
attached).  Opens a Scan For New Devices window from which to choose 
whether or not to continue. 

 
The Refresh button refreshes a directory view.  If you copy files into a 
directory using Windows Explorer, the DN9696 may not see the update 
immediately. 

Copying files 

We do not recommended copying files via the Disk Management window; 
Windows Explorer will be quicker. 

Importing files 

There is a right-click menu option for 'Import into Clipstore', which is the same as 
the 'Import Source Files' function in the Source Files Folder.  Windows Explorer 



has a similar function, whereby you can drag files from Explorer into the Source 
Files Folder, or directly into place in the playlist.  If you press CTRL while 
dragging files they will be copied, as opposed to being imported from their 
existing locations. 

 



Input Monitor Window 

The Input Monitor window displays channel status information, as transmitted 
in the AES50 stream, and reports any error conditions. 

 

By switching on the Pop up automatically on error button, you can set this 
window to pop up automatically when an error occurs. 

The error conditions are shown in the Error Log panel.  Each error condition is 
listed with the time it occurred and a description of the error itself.  To clear the 
error log, click Clear. 

To close the Input Monitor window, click Close. 

 



Sync Monitor Window 

The Sync Monitor Window displays information about any incoming LTC (if 
enabled) and shows a graph of any deviation in speed from the base sample rate. 

 

External TC Time N/A. 

Internal TC Time N/A. 

Sample Rage N/A. 

Sample Error N/A. 

Timecode Status 
(LTC) 

N/A. 

Video Reference N/A. 

 

The DN9696 will be using the Audio Clock source (which is usually set to genlock 
to the incoming AES50 source) as the master clock reference, but any incoming 
LTC can be used to trigger playback or recording at a particular playlist time.  So, 
the initial time represented by the timecode sets the playlist position at which the 
DN9696 will play or record; thereafter the DN9696 will 'free-run' with respect to 
the LTC, but remains clocked from its audio reference. 



The incoming LTC should be synchronous to the master AES50 clock.  Otherwise, 
the LTC will not really have much purpose.  For example, if the audio recorded at 
one hour is actually at one hour and four seconds (an error of approximately 
0.1%), any synchronising process after the event will be awkward. 

A small amount of sample deviation is to be expected, but if the LTC and master 
clock are not in sync, then the graph drawn and the 'sample error' field in the 
Sync Monitor Window will become increasingly large (positive or negative). 

As the primary task of the DN9696 is to record audio, when any deviation 
becomes large, or even if the LTC disappears or jumps to a new timecode 
position, the errors will accumulate in the Sync Monitor Window, but 
RECORDING WILL CONTINUE! 

 



Record Status Message Window 

The Record Status Messages window captures any errors on disk drives during 
recording.  Although these are also reported to the disk drive information sections 
(right side of the screen), this window collects specific information about the 
problem. 

 

 

Clear Clears all of the record status messages. 

Copy Copies the text to the windows' paste buffer, so that it can 
be pasted into a Notepad text file and be saved separately. 

Pop up 
automatically on 
error 

When selected (ticked) the Record Status Messages 
window opens automatically when an error occurs. 

Close Closes the Record Status Messages window. 

 



Appendices 

 

 

 



 

 



Work Flow 

Transferring a DN9696 project to Pro Tools 

If you (or another engineer in the production chain) want to use the DN9696 
recordings on a DAW for post-production, this section describes the basic steps 
needed to import the files into a Pro Tools HAD system in a way that will be the 
most convenient to work with. 

There is no need for an export procedure from the DN9696, as Pro Tools can work 
with the recorded audio files. 

File formats 

Files are recorded in the DN9696 as standard BWF file format at 96kHz sampling 
rate and 24-bits resolution. 

These files include metadata in the Avid/Deva and iXML formats, the same as that 
produced by most location recorders.  Both of these metadata formats are easily 
handled by up-to-date Digidesign Pro Tools systems (HAD v7.2 and higher) and 
in these more recent software versions, the files will be grouped, ordered and 
labelled better than in earlier Pro Tools versions, making the files much easier to 
deal with. 

Disk drives 

Each set of up to 96 files recorded in the DN9696 will usually be evenly spread 
across two disk drives, with up to 48 tracks of 96kHz/24-bit audio on each drive. 

Pro Tools systems may not be able to reliably play back this amount of audio data 
from only two disks.  Current Digidesign recommendations suggest that between 
six (SCSI) and eight (FireWire) drives are required to play 96 tracks of 96kHz/24-
bit audio, but as technology is continually moving forward we recommend that 
you to check this with a Pro Tools expert.  This Pro Tools limitation probably 
means that the audio files will need to be copied from the DN9696 disk drives to 
multiple drives attached to the Pro Tools system.  If the files are being copied, 
the DN9696 disk drive format is relatively unimportant.  However, the format of 
the disk drives that you are intending to use on the Pro Tools may be significant. 

Pro Tools has a scheme for ‘Audio and Video Volume Designators’ whereby drives 
can be designated as "R" (record and playback), "P" (playback only) and "T" 
(transfer).  Disks marked as "Transfer" cannot be used for playback; when Pro 
Tools imports files from a transfer designated drive the files will be copied to a "P" 
or "‘R" designated drive. 

For example, a Mac OS-X based Pro Tools HAD system supports both NTFS and 
FAT32 formats as Transfer-only, and Pro Tools will copy any files of these drives 
to a Mac HFS+ formatted drive as it imports.  So, there are two possibilities: 

1. Record in the DN9696 on two NTFS or FAT32 formatted drives, and then 
copy the files to six Mac HFS+ formatted drives for the Pro Tools to use. 
 If the files have to be copied to more drives, the format of the DN9696 
drives is unimportant. 



2. If you are sure that the Pro Tools is able to play directly from the DN9696 
drives, then it will save a copy process to record directly to Mac HFS+ 
drives.  Mac HFS+ drives can be supported on the DN9696 system if the 
MacDrive utility software is installed. 

To check the ‘Volume Designators’ information in Pro Tools, open the window 
menu and select Workspace.  There is a column marked "A" (for audio – with a 
"V" for video column next to it) which displays an "R", "P" or "T" against each disk 
drive that Pro Tools can see.  The diagram below shows a typical example of the 
‘Volume Designators’ screen. 

 

Importing the audio files 

1. On opening Pro Tools, you will need to create a new session.  Set the 
Audio File Type to BWF, Sample Rate to 96kHz and Bit Depth to 24-bit. 

2. Go to the Track menu, and select New Tracks.  Create 96 new tracks (or 
however many tracks the project requires). 

3. From the File menu, choose Import, then Audio.  Navigate to where the 
files from the DN9696 are located, select those files and press the Add All 
button.  Select Done when finished. 

4. A small Audio Import Options window will open, and you will be asked to 
choose the Destination for the Import.  We recommend that you select 
Region List. 

5. Repeat and import files from all the drives as required. 

6. If not currently displayed to the right of the Edit Window, show the Region 
List by pressing the << symbol (lower-right corner of the window). 

7. For each multi-channel recording there should be a single entry in the 
Region List.  You can expand that entry to see the channels inside by 
pressing the small triangle button (left of name). 

8. Having imported the audio files, you can now drag them to the Pro Tools 
Edit Window.  To make sure that each recording is placed at its original 
time, we suggest that you use Spot mode. 

9. Press the Spot button (upper-left corner of Edit window).  If the 'Auto-
Spot Regions' is enabled, this may spoil this; disable it first in the Options 
menu. 

10. Drag each entry from the Region List and drop it into the Edit Window. 



11. The Spot Dialog window opens (a typical example is shown below). 

 

12. In the Spot Dialog window, press the Original Time Stamp up arrow 
button to force the entry to be placed at its original time. 

13. Notice that the metadata in the file is displayed on each channel of the clip 
in the Edit Window.  In the example below you can see that the multi-
channel recording is called “rehearsals_004”, but the instrument name 
appears in brackets on each channel.  This is the same text that has been 
typed into the DN9696’s track name to label that channel. 



 

 



iXML Implementation 

iXML v1.4 

iXML Master Tag iXML Sub Tag Written Read Notes 

     

<PROJECT>  O O Project 

<SCENE>  O O Scene 

<TAKE>  O O Take 

<TAPE>  O O Tape (user definable) 

<CIRCLED>  O O Circled 

<FILE_UID>  O O  

<UBITS>  O O UBITS(user definable) 

<NOTE>  O O Note (user definable) 

<BEXT>  X O  

<USER>  O O User (+ any non-std. fields)* 

     

<SPEED>     

<SPEED> <NOTE> X O  

<SPEED> <MASTER_SPEED> X O  

<SPEED> <CURRENT_SPEED> X O  

<SPEED> <TIMECODE_FLAG> O O  

<SPEED> <TIMECODE_RATE> O O  

     

<SYNC_POINT_LIST>     

<SYNC_POINT> <SYNC_POINT_TYPE> X O  

<SYNC_POINT> <SYNC_POINT_FUNCTION> X O  

<SYNC_POINT> <SYNC_POINT_COMMENT> X O  

<SYNC_POINT> <SYNC_POINT_LOW> X O  

<SYNC_POINT> <SYNC_POINT_HIGH> X O  

<SYNC_POINT> <SYNC_POINT_EVENT_DURATION> X O  

     

<HISTORY>     

<HISTORY> <ORIGINAL_FILENAME> O O  

<HISTORY> <PARENT_FILENAME> X O  

<HISTORY> <PARENT_UID> X O  



     

<FILE_SET>     

<FILE_SET> <TOTAL_FILES> O O  

<FILE_SET> <FAMILY_UID> O O  

<FILE_SET> <FAMILY_NAME> X O  

<FILE_SET> <FIEL_SET_INDEX> O O  

     

<TRACK_LIST>     

<TRACK_LIST> <TRACK_COUNT> O O  

<TRACK_LIST> <CHANNEL_INDEX> O O  

<TRACK_LIST> <INTERLEAVE_INDEX> O O  

<TRACK_LIST> <NAME> O O  

<TRACK_LIST> <FUNCTION> X O  

 

O = yes, and X = no. 

* DN9696 allows custom metadata fields to be created, and any that are non-standard titles are 
added to the USER field. 

 





Glossary 

3 
3-D: Abbreviation for "three-dimensional". 

A 
ADL: Abbreviation for "audio decision list". 

AES50: AES digital audio engineering standard. AES50 is a high resolution, multi-
channel audio interconnection (HRMAI). Rather than a network, it is a 
high-performance, point-to-point audio interconnection, although the 
auxiliary data may operate as a true network, independently of the audio. 
HRMAI provides a professional multi-channel audio interconnection that 
uses Cat5 data cable and is compatible with Ethernet networks. 

B 
Box select: A method of selection using drag. 

BWF: Abbreviation for "broadcast wave format". 

C 
Click: The action of using the left mouse button to select an on-screen element, 

such as a button or command. 

D 
DAW: Abbreviation for "digital audio workstation". 

dBFS: Abbreviation for "decibels full scale". 

Drag: The action of clicking the left mouse button, holding it down, and then 
moving the mouse. For example, to resize a window or to 'box select'. 

E 
EDL: Abbreviation for "edit decision list". 

eSATA: An external SATA device. See "SATA". 

F 
FireWire 800: Cable and interface standard for data transmission between 

devices at up to 800Mbps. 

H 
HDD: Abbreviation for "hard disk drive". A non-volatile storage device. 

Hotkey: A pre-assigned or user-assigned keyboard shortcut. Provides a method 
of speeding up operations or a quick way of doing repetitive tasks. 



I 
iXML: An open standard for inclusion of metadata in a BWF file. This is also 

supported by a number of audio workstations. See "XML". 

L 
LED: Abbreviation for "light emitting diode". 

LTC: Abbreviation for "linear time code". Also known as "longitudinal time code" 
and "SMPTE". 

M 
Mbps: Abbreviation for "megabits per second" (also shown as Mbit/s). A unit of 

data transfer rate. 

ms: Abbreviation for "milliseconds". 

N 
N/A: Abbreviation for "not applicable". 

P 
PC: Abbreviation for "personal computer". 

PLE: Abbreviation for "playlist edit". 

Pointer: An on-screen icon (arrow or other shaped object) that moves with the 
mouse or other pointing device. 

PPM: Abbreviation for "peak program meter". 

Pro Tools: DAW platform for Windows (Microsoft and Mac OS) operating 
systems. 

R 
Right-click: The action of using the right mouse button, instead of the more 

usual left mouse button. This usually opens an element- or area-specific 
menu. 

rpm: Abbreviation for "revolutions per minute". 

S 
SATA: Abbreviation for "serial advanced technology attachment". A computer bus 

technology designed primarily for the transfer of data to/from a hard disk. 
Also used to describe a drive that utilises this technology. 

Sync: Abbreviation for "synchronisation". 

T 
Timeline: For audio recordings, the graphical representation of an audio signal 

over a period of time. 



Tooltip: A box that appears when the pointer pauses over a screen element, 
such as a button or clip. Its purpose is to provide you with information on 
that element. 

Transport controls: Controls used for controlling a recording. 

U 
US: Abbreviation for "United States". 

USB: Abbreviation for “universal serial bus”. A ‘plug and play’ interface that 
provides a fast connection between a computer and peripherals, such as 
keyboards, printers, scanners, digital cameras etc. 

V 
Virtual soundcheck: To temporarily patch a live recording made during a 

rehearsal or performance to selected console inputs for set-up or 
adjusment. This can be done when the performers aren't available. 

W 
WAV: Abbreviation for "waveform audio format". 

X 
XGA: Abbreviation for "extended graphics array". 

XML: Abbreviation for "extensible markup language". 
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